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Ph. D. COURSEWORK 
Syllabus for Module-2 : ICT (Information and Communication Technology ) Skills 
(Syllabus for the faculties of Science and Technology, Commerce and Management, 

Humanities, Inter-disciplinary Studies 
Teaching scheme Examination Scheme 

Term Work: 04 Hrs/week Term Work: 50 Marks 
Credits : 02 

Course objectives: 

 To learn and acquire the skills using ICT tools.. 
 To learn the basics of Information Technology. 
 To learn and acquire the word processing skills. 
 To learn and acquire the spreadsheet processing skills. 
 To learn and acquire the presentation skills using ICT tools. 
 To learn and acquire the internet searching using ICT tools. 
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Unit I :INTRODUCTION 
IT (Information Technology),ICT (Information and Communication Technology) 
CT (Computer Technology) Characteristics of a Computer, Limitations of a Computer Different 
Types of Computers, Different Types of Personal Computers (PCs) . Main parts of a Computer 
system : Processing Devices, Memory Devices, Input Devices, Output Devices, Storage Devices. 
Categories of Software, Application Software. Computer Network: Basic hardware and 
terminology in networks, Classifications of Computer Networks, The Internet, The Intranet and 
Extranet. 
 
Unit II :INTRODUCTION TO OPERATING SYSTEM & WORD 
PROCESSING SOFTWARE 
(Latest Versions of the Operating System/ Word Processing Software are Recommended) 
Installing Windows, Basic Operations in Windows, Interface, Introduction to Windows File 
System, Storing and Managing Data, Windows User Accounts, The System Settings. Adjusting 
the 
Computers Settings. Introduction to MS Office. Word Processing with MS-Word : basic 
operations- Editing, Proofing, and Formatting text, paragraphs and pages, Printing the 
documents. 
Working with tables, images. Mail merge. Working with Charts, Equations, Symbols. 
 
Unit III : INTRODUCTION TO SPREADSHEET SOFTWARE 
(Latest Version of the Spreadsheet Software is Recommended) 
Introduction to MS Excel and its User Interface. Working with workbooks, work sheets. Data 
Entry 
techniques. Defining data set as a Table. Setting, Previewing, and Printing under MS-Excel. 
Performing Calculations on Data. Working with Excel Formulas, Functions and Charts. Sorting/ 
Filtering data. 
 
 
Unit IV : INTRODUCTION TO PRESENTATION SOFTWARE 
(Latest Version of the Presentation Software is Recommended) 
Working with MS PowerPoint. Presentation Basics. Adding more components to the slides, 
Formatting Presentations, backgrounds and layout. Applying Themes. Using Slide Master. 
Working 
with Graphics, Images and Clips. Working with Multimedia. Inserting Sound and Narration. 
Delivering Presentations. Animating Objects. Adding Action effects. Live Presentation. Using 
Custom Shows. Saving/Protecting the Presentation. Printing the slides. 
 
Unit V : INTRODUCTION TO THE INTERNET 
The Internet: an introduction, Meaning and benefits of the Internet? The history of the 
Internet, Differences between Internet and World Wide Web. Connecting to the Internet. 
Web Browsers. User Interfaces of Web Browsers. Browser Customization. Search 
Engines. E-mail: Basic Concepts and terminologies. Using emails. Security and risk in 
Internet. 
E-commerce. E-learning. E-Government. E-entertainment. Top Ten Future Trends- The 
Internet by 2020 
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IT (Information Technology) 
Information technology (IT) is the use of any computers, storage, networking and other physical 
devices, infrastructure and processes to create, process, store, secure and 
electronic data. Typically, IT is used in the context of business operations, as opposed to 
technology used for personal or entertainment purposes. The commercial use of IT encompasses 
both computer technology and telecommunications.
Information technology (IT) is the use of computer systems or devices to access information. 
Information technology is responsible for such a large portion of our workforce, business 
operations and personal access to information that it comprises much of o
Whether you are storing, retrieving, accessing or manipulating information, IT greatly impacts 
our everyday lives. 
 
 
ICT (Information and Communication Technology)

Information and Communications Technology (ICT) is the convergence of
telecommunication and governance policies for how information should be accessed, secured, 
processed, transmitted and stored.
In some parts of the world, ICT is used as a synonym for
two terms can have slightly different meanings when used in different contexts. For example, in 
the United States the label IT is used when discussing technology in terms of business operations 
-- while the label ICT is used more often in the context of education and government.
ICT has become an umbrella term in many parts of the world as digital communication links 
replace analog links -- and the demand for professionals who have the knowledge and skills to 
manage the convergence of these links grows.
To that end, ICT employees can expect to work in positions where the focus of their job includes 
improving digital literacy, data literacy
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Unit I :INTRODUCTION 

Information technology (IT) is the use of any computers, storage, networking and other physical 
devices, infrastructure and processes to create, process, store, secure and exchange all forms of 
electronic data. Typically, IT is used in the context of business operations, as opposed to 
technology used for personal or entertainment purposes. The commercial use of IT encompasses 
both computer technology and telecommunications. 
Information technology (IT) is the use of computer systems or devices to access information. 
Information technology is responsible for such a large portion of our workforce, business 
operations and personal access to information that it comprises much of our daily activities. 
Whether you are storing, retrieving, accessing or manipulating information, IT greatly impacts 

ICT (Information and Communication Technology) 

 
Information and Communications Technology (ICT) is the convergence of computing, 
telecommunication and governance policies for how information should be accessed, secured, 
processed, transmitted and stored. 
In some parts of the world, ICT is used as a synonym for information technology
two terms can have slightly different meanings when used in different contexts. For example, in 
the United States the label IT is used when discussing technology in terms of business operations 

hile the label ICT is used more often in the context of education and government.
ICT has become an umbrella term in many parts of the world as digital communication links 

and the demand for professionals who have the knowledge and skills to 
manage the convergence of these links grows. 
To that end, ICT employees can expect to work in positions where the focus of their job includes 
improving digital literacy, data literacy and using emerging technologies to optimize legacy 
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Information technology (IT) is the use of any computers, storage, networking and other physical 
exchange all forms of 

electronic data. Typically, IT is used in the context of business operations, as opposed to 
technology used for personal or entertainment purposes. The commercial use of IT encompasses 

Information technology (IT) is the use of computer systems or devices to access information. 
Information technology is responsible for such a large portion of our workforce, business 

ur daily activities. 
Whether you are storing, retrieving, accessing or manipulating information, IT greatly impacts 

computing, 
telecommunication and governance policies for how information should be accessed, secured, 

information technology (IT), but the 
two terms can have slightly different meanings when used in different contexts. For example, in 
the United States the label IT is used when discussing technology in terms of business operations 

hile the label ICT is used more often in the context of education and government. 
ICT has become an umbrella term in many parts of the world as digital communication links 

and the demand for professionals who have the knowledge and skills to 

To that end, ICT employees can expect to work in positions where the focus of their job includes 
and using emerging technologies to optimize legacy 
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communication channels. This includes researching how emerging technologies such as 
augmented (AR) and virtual reality (
communication theories. 
Advertisement 
Techopedia Explains Information and Communications Technology (ICT)
ICT includes traditional data center infrastructure
content, software, hardware and support services delivered over 
ICT Components 
ICT components include: 

 Hardware components that support the way information is created, transferred, stored and 
managed. 

 Software as a Service (SaaS
personal productivity and workflow management.

 Electronic components that support the exchange of digital information, including 
subscription service delivery mechanisms.

 Services that support IT asset management
experience management, 

ICT exclusions typically include computing
well as personal computing devices and peripherals such as game consoles and ear buds.
IT vs. ICT 
In the United States, the term information technology (IT) is used more often in the context of 
business operations, while ICT is used more often in education and government content.
Now that telephone networks have merged with computer network systems and communication 
technologies have increasingly become digital, the need to differentiate between line
entries for IT and communication technologies components is expected to fade away. Experts in 
the U.S. are divided as to whether government and education will event
IT or continue to use ICT. 
ICT is already the preferred label in most other parts of the world because it includes what is 
arguably the most important purpose of technology 
exchange information. 
 
 
CT (Computer Technology) 
Computer Technology means: (a) computer hardware, software, or both, that shall meet or 
exceed any specifications required by law, for each eligible house
Students reside, and (b) any computer hardware, software, or both, required by Administrative 
Staff or Teachers. 
it is a broad term that refers to computer
or associated with computers and devices with a central processing unit, such as the hardware 
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communication channels. This includes researching how emerging technologies such as 
) and virtual reality (VR) can support traditional technologies and 

Techopedia Explains Information and Communications Technology (ICT) 
data center infrastructure components as well as an increasing number of 

content, software, hardware and support services delivered over the internet. 

Hardware components that support the way information is created, transferred, stored and 

SaaS) and local client applications that support digital design, 
personal productivity and workflow management. 
Electronic components that support the exchange of digital information, including 
subscription service delivery mechanisms. 

IT asset management, data lifecycle management, customer 
 digital employee experience management and data literacy.

ICT exclusions typically include computing-related office supplies such as printer toner 
well as personal computing devices and peripherals such as game consoles and ear buds.

the term information technology (IT) is used more often in the context of 
business operations, while ICT is used more often in education and government content.
Now that telephone networks have merged with computer network systems and communication 

logies have increasingly become digital, the need to differentiate between line
entries for IT and communication technologies components is expected to fade away. Experts in 
the U.S. are divided as to whether government and education will eventually adopt the acronym 

ICT is already the preferred label in most other parts of the world because it includes what is 
arguably the most important purpose of technology – improving the way people and machines 

means: (a) computer hardware, software, or both, that shall meet or 
exceed any specifications required by law, for each eligible household in which one (1) or more 
Students reside, and (b) any computer hardware, software, or both, required by Administrative 

computer software and hardware.  Refers to inventions related to 
s and devices with a central processing unit, such as the hardware 

and software of computer
and storage devices. 
 
Characteristics of a Computer, 
 
1. Speed: – As you know 
work very fast. It takes only few seconds 
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communication channels. This includes researching how emerging technologies such as 
) can support traditional technologies and 

components as well as an increasing number of 

Hardware components that support the way information is created, transferred, stored and 

) and local client applications that support digital design, 

Electronic components that support the exchange of digital information, including 

, data lifecycle management, customer 
and data literacy. 

related office supplies such as printer toner -- as 
well as personal computing devices and peripherals such as game consoles and ear buds. 

the term information technology (IT) is used more often in the context of 
business operations, while ICT is used more often in education and government content. 
Now that telephone networks have merged with computer network systems and communication 

logies have increasingly become digital, the need to differentiate between line-item budget 
entries for IT and communication technologies components is expected to fade away. Experts in 

ually adopt the acronym 

ICT is already the preferred label in most other parts of the world because it includes what is 
improving the way people and machines 

means: (a) computer hardware, software, or both, that shall meet or 
hold in which one (1) or more 

Students reside, and (b) any computer hardware, software, or both, required by Administrative 

Refers to inventions related to 
s and devices with a central processing unit, such as the hardware 

computers, the Internet 

Characteristics of a Computer,  

 computer can 
work very fast. It takes only few seconds 
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for calculations that we take hours to complete. You will be surprised to know that computer can 
perform millions (1,000,000) of instructions and even more per second. 
Therefore, we determine the speed of computer in terms of microsecond (10-6 part of a second) 
or nanosecond (10 to the power -9 part of a second). From this you can imagine how fast your 
computer performs work. 
 
2. Accuracy: – The degree of accuracy of computer is very high and every calculation is 
performed with the same accuracy. The accuracy level is 7. 
determined on the basis of design of computer. The errors in computer are due to human and 
inaccurate data. 
3. Diligence: – A computer is free from tiredness, lack of concentration, fatigue, etc. It can work 
for hours without creating any error. If millions of calculations are to be performed, a computer 
will perform every calculation with the same accuracy. Due to this capability it overpowers 
human being in routine type of work. 
 
4. Versatility: – It means the capacity to perform completely different type of work. You may 
use your computer to prepare payroll slips. Next moment you may use it for inventory 
management or to prepare electric bills. 
5. Power of Remembering: – Computer has the power of storing any amount of information or 
data. Any information can be stored and recalled as long as you require it, for any numbers of 
years. It depends entirely upon you how much data you want to store in a computer and when to 
lose or retrieve these data. 
 
6. No IQ: – Computer is a dumb machine and it cannot do any work without instruction from the 
user. It performs the instructions at tremendous speed and with accuracy. It is you to decide what 
you want to do and in what sequence. So a computer cannot take its own decision as you can.  
7. No Feeling: – It does not have feelings or emotion, taste, knowledge and experience. Thus it 
does not get tired even after long hours of work. It does not distinguish between users. 
8. Storage: – The Computer has an in-built memory where it can store a large amount of data. 
You can also store data in secondary storage devices such as floppies, which can be kept outside 
your computer and can be carried to other computers. 
 
 

Limitations of a Computer 
The computer can easily beat humans in terms of speed, accuracy, and management of memory, 
but stills computer has many limitations. 
Here, are some limitations: 
1. Computer are programmed by Humans 
Computers are programmed by human beings like An Artificial intelligence (AI) refers to the 
simulation of human intelligence in which the machines are programmed to think like humans 
and their actions. The computer only follows that instruction which is programmed by humans. If 
those instructions are not accurate then the working of the computer will not accurate. 
This is the main limitation of an computer. 
2. Emotionless 
Computers are emotionless. They do not have any emotions and feelings. A computer cannot 
understand what humans are thinking and feeling. It’s just a machine where it works when 
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humans give the instruction to them, and it can not compete the humans in relation but it can 
compete in term of speed, accuracy, etc. only. 
3. NO INTELLIGENCE 
A computer does not carry any tasks on his own and can’t take any decision on it owns like 
humans, Computer will only work when humans gives the instructions or programs, it only 
depends on it. 
We all know that computers are faster than humans in terms of speed, giving accurate results and 
more brilliant than humans but they cannot replace humans. 
4. NO THINKING 
Computers are not smart in any way and they cannot think themselves. The concept of AI means 
Artificial Intelligence shows that the computer actually thinks but still this concept work on the 
dependent on the sets of instruction and program which is done by human beings. 
5. SELF CARE 
A computer can not care for itself like a human and they have no sense to do it by own. For the 
computer, there has only one God named “humans”. Computer is nothing without humans and 
they are only dependent on humans for the purpose of instruction. 
6. RETREIVAL OF MEMORY 
Retrieval of memory means it remembered all the information which are stored in memory. 
Computers can retrieve data very fast but this technique is in linear. A normal human being’s 
mind does not follow this rule because humans almost forgot data in their mind which are not 
useful. A human mind can think randomly which a computer machine can not. 
In simple words, the computer does those tasks which humans normally cannot do. On the other 
hand, computers cannot do those tasks Which humans normally can do. 
 
 

Different Types of Computers, 
A computer is a device that transforms data into meaningful information. It processes the input 
according to the set of instructions provided to it by the user and gives the desired output. 
Computers are of various types and they can be categorized in two ways on the basis of size and 
on the basis of data handling capabilities. 
So, on the basis of size, there are five types of computers: 

1. Supercomputer 
2. Mainframe computer 
3. Minicomputer 
4. Workstation 
5. PC (Personal Computer) 

And on the basis of data handling capabilities, there are three types of computer: 
1. Analogue Computer 
2. Digital Computer 
3. Hybrid Computer 

Now let us discuss each type of computer in detail: 
1. Supercomputer: 
When we talk about speed, then the first name that comes to mind when thinking of computers is 
supercomputers. They are the biggest and fastest computers(in terms of speed of processing 
data). Supercomputers are designed such that they can process a huge amount of data, like 
processing trillions of instructions or data just in a second. This is because of the thousands of 
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interconnected processors in supercomputers. It is basically used in scientific and engineering 
applications such as weather forecasting, scientific simulations, and nuclear energy research. It 
was first developed by Roger Cray in 1976. 
Characteristics of supercomputers: 

 Supercomputers are the computers which are the fastest and they are also very expensive. 
 It can calculate up to ten trillion individual calculations per second, this is also the reason 

which makes it even more faster. 
 It is used in the stock market or big organizations for managing the online currency world 

such as bitcoin etc. 
 It is used in scientific research areas for analyzing data obtained from exploring the solar 

system, satellites, etc. 
2. Mainframe computer: 
Mainframe computers are designed in such a way that it can support hundreds or thousands of 
users at the same time. It also supports multiple programs simultaneously. So, they can execute 
different processes simultaneously. All these features make the mainframe computer ideal for big 
organizations like banking, telecom sectors, etc., which process a high volume of data in general. 
 
Characteristics of mainframe computers: 

 It is also an expensive or costly computer. 
 It has high storage capacity and great performance. 
 It can process a huge amount of data (like data involved in the banking sector) very 

quickly. 
 It runs smoothly for a long time and has a long life. 

3. Minicomputer: 
Minicomputer is a medium size multiprocessing computer. In this type of computer, there are 
two or more processors, and it supports 4 to 200 users at one time. Minicomputers are used in 
places like institutes or departments for different work like billing, accounting, inventory 
management etc. It is smaller than a mainframe computer but larger in comparison to the 
microcomputer. 
Characteristics of minicomputer: 

 Its weight is low. 
 Because of its low weight, it is easy to carry anywhere. 
 less expensive than a mainframe computer. 
 It is fast. 

4. Workstation: 
Workstation is designed for technical or scientific applications. It consists of a fast 
microprocessor, with a large amount of RAM and high speed graphic adapter. It is a single-user 
computer. It generally used to perform a specific task with great accuracy. 
Characteristics of Workstation: 

 It is expensive or high in cost. 
 They are exclusively made for complex work purposes. 
 It provides large storage capacity, with better graphics, and a more powerful CPU when 

compared to a PC. 
 It is also used to handle animation, data analysis, CAD, audio and video creation, and 

editing. 
5. PC (Personal Computer): 



These notes are edited for Academic Purpose and Private Circulation Only 

Information and Communication Technology 
Ph.D Cell Loknayak Bapuji Aney Mahila Mahavidyalaya, Yavatmal  8 

It is also known as a microcomputer. It is basically a general-purpose computer and designed for 
individual use. It consists of a microprocessor as a central processing unit(CPU), memory,  input 
unit, and output unit. This kind of computer is suitable for personal work such as making an 
assignment, watching a movie, or at office for office work, etc. For example, Laptops and 
desktop computers. 
Characteristics of PC (Personal Computer): 

 In this limited number of software can be used. 
 It is smallest in size. 
 It is designed for personal use. 
 It is easy to use. 

6. Analogue Computer: 
It is particularly designed to process analogue data. Continuous data that changes continuously 
and cannot have discrete values is called analogue data. So, an analogue computer is used where 
we don’t need exact values or need approximate values such as speed, temperature, pressure etc. 
It can directly accept the data from the measuring device without first converting it into numbers 
and codes. It measures the continuous changes in physical quantity. It gives output as a reading 
on a dial or scale. For example speedometer, mercury thermometer, etc. 
7. Digital Computer: 
Digital computers are designed in such a way that it can easily perform calculations and logical 
operations at high speed. It takes raw data as an input and processes it with programs stored in its 
memory to produce the final output. It only understands the binary input 0 and 1, so the raw 
input data is converted to 0 and 1 by the computer and then it is processed by the computer to 
produce the result or final output. All modern computers, like laptops, desktops including 
smartphones are digital computers. 
8. Hybrid Computer: 
As the name suggests hybrid, which means made by combining two different things. Similarly, 
the hybrid computer is a combination of both analog and digital computers. Hybrid computers 
are fast like an analog computer and have memory, and accuracy like a digital computer. So, it 
has the ability to process both continuous and discrete data. For working when it accepts analog 
signals as input then it converts them into digital form before processing the input data. So, it is 
widely used in specialized applications where both analog and digital data is required to be 
processed. A processor which is used in petrol pumps that converts the measurements of fuel 
flow into quantity and price is an example of a hybrid computer. 
 

Different Types of Personal Computers (PCs) 
 
Personal computer - categories of computers 
Personal computers are the most common used computers among general people. We can not 
think a day without using computers. The future technology is mostly dependent on computer. 
Perhaps, you may have used several personal computers in your life. In this article, I will tell you 
about different types of personal computers and their categories according to their use. 
Two main categories of computers are personal computer and organizational computer. 
Computers have also several types according to personal use or organizational use. Most 
computers are usually used by only one person at a time which is called personal computer or 
PC. 
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These types of computers are often shared by several people but only one user can work with it 
at any given instant. We will describe here about only personal computer. To know 
about organizational computer click here. 
Six main types of personal computer 
Generally we use different types of computer for different purpose. We can divided them 
according to single used and organizational used. Here are the six main types of personal 
computers we used today. 

1. Desktop Computers 
2. Workstations 
3. Notebook computers or laptops 
4. Tablet computers 
5. Handheld computers 
6. Smartphones 

These are all example of personal computers which refers to any computer system that is 
designed for used by a single user only. But you have to consider that these can also be shared 
which I have mentioned earlier. 
PCs are also called microcomputers because they are the smallest computer created for people 
to use. For this, the term personal computer or PC is most often used to describe desktop 
computer. 
Although this types of computers are used by individuals, they can also be connected together to 
create networks for working together with different personal computers. 
In fact, networking has become one of the most important jobs of personal computers. But 
nowadays, any handheld computers can also be connected to the networks. 
Desktop Computer 
The most common type of personal computer is the desktop computer. It is a PC that is 
designed to sit on a desk or a table. These are the system you see around you in schools, colleges, 
universities, homes and offices. 
Today’s desktop computers are more powerful than that of a few years ago. Personal computers 
are used for various types of tasks. 
It is being used by everyone from preschoolers to nuclear physicists as well as desktop 
computers are indispensable for learning, working as well as playing. 
 
 
 
 
Workstation 
A workstation is a specialized personal computer. It is single user which has more power and 
features than a standard PC. These machines are popular among scientists, engineers, and 
animators who need a greater speed power to perform sophisticated tasks. 
 
Workstations often has large, high resolution monitors and accelerated graphics handling 
capabilities which makes them suitable for advanced architectural or engineering design, 
modeling, animation video editing etc. 
Notebook computer or Laptop 
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Notebook computers are another types of personal computer which is getting more popularity 
day by day. It is very small in size and can easily fit inside a brief case. 
 
They are also called laptop computers because people frequently set these devices on their lap. 
Notebook computer can be operated by both alternating current and direct current by battery. 
It’s weight is less than 8 pounds. During use, the computer’s lid is raised to reveal a thin monitor 
and a keyboard. When not in use, the device folds up for easy storage. 
It is a fully functional microcomputer or personal computer. People who need the power of a 
full size desktop computer wherever they go outside, use notebook. 
Some notebook computers are designed to be plugged into a docking station, which includes a 
large monitor, a full size keyboard and mouse or other devices. 
Docking stations also provide additional ports that enable the note book computer to be 
connected to different devices or a network in the same manner as a desktop personal computer. 
 
Tablet computer 
Tablet computer is the newest development in portable, full- featured personal computer. Tablet 
PCs offer all the functionality of a notebook computer. 
They are lighter and can accept input from a special pen called a stylus or a digital pen. Stylus is 
used to tap or write directly on the screen.  
Some tablet PCs also have a built-in microphones and special software that accepts input from 
the user’s voice. Some have a fold-out keyboard, so they can be transformed into a standard 
notebook computer. 
Tablet PCs run specialized versions of standard programs and can be connected to a network as a 
personal computer. Some models also can be connected to a keyboard and a full-size monitor. 
 
Handheld computer 
Handheld computers are another types of personal computer which are small enough to fit in 
your hand. The Personal Digital Assistant (PDA) is the popular types of handheld computers. 
PDA is used for special applications such as taking notes, displaying telephone numbers and 
addresses, and keeping track of dates or agendas. Many PDAs can be connected to larger 
computers to exchange data. 
Many PDAs let the user access the internet through a wireless connection as a personal 
computer. Several models offer features such as cellular telephones, cameras, music players, and 
GPS. 
Smartphone 
Smartphones which are the most uses personal computers now a days. There are hardly a person 
who has not a smartphone. These are very small and can easily portable to your pocket. 
Smartphone is the smallest types of PC now a days. Almost everyone have a smartphone today 
by which a man can connect to the internet. 
One can get the features like web and email access, special software such as personal organizers, 
or special hardware such as digital cameras or music players. It has made our life easy because 
we can easily take it with us and use whenever need. 
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Main parts of a Computer system: 
 
Processing Devices,  
 
 
It is an essential device that every computer user must know about computer devices and storage 
devices with their purpose.  
There are two main types of computer hardware devices, external hardware devices, and internal 
hardware devices.  
External hardware is external hardware used outside of the computer, and internal hardware is 
internal hardware used within the computer.  
The keyboard and mouse are input devices through which we give commands to the computer. 
Examples are opening any software and running it or creating any file with a given command.  
All of this process requires processing that is done by the computer.  

 Processor/CPU: Processor is an acronym for Central Processing Unit (CPU). The CPU 
is the computer’s brain and is situated on the motherboard. We use the computer to 
calculate the trial of anything we do in the computer, which is known to the computer 
because the processing does anything we do in the computer. The computer receives the 
command from the program files when we choose an icon from the software and give it. 
Later, the computer opens the program and displays the output on the output device, such 
as the monitor. 

 GPU: GPU (Graphics Processing Unit), known as Graphics card, is used for processing 
good videos and pictures, but it is not the main component of the computer since the 
computer uses onboard graphics connected to the motherboard and are what control the 
standard graphics. A person who plays video games and creates high-quality videos with 
that device is likely to need a GPU to process the heavy graphics in the game and the 
high-quality videos, so they need a GPU to do it. 

 Video Card: A video card is similar to a graphic card, but it has a lower processing 
power than a graphic card; video cards are built directly into computers’ motherboards; 
so it’s like a small part of the GPU that works slowly. 

 Motherboard: This is an essential device of the computer; with the help of this device, all 
other devices are connected to the laptop or desktop computer. 

 Sound Card: With the help of this card, we can play any sound saved in our device. The 
computer is able to save all types of sound binary code language for decode this; there is 
a sound card available in laptop, mobile, speaker. 

 
 
Input Devices,  
 
The electromagnetic devices that accept data or a set of instructions from the outside world and 
then translate that data into machine-readable and understandable form are known as input 
devices. Computer input devices serve as an interface between the outside world and the 
computer for proper communication. When the users enter data using various input devices, the 
data can be saved in computer memory for further processing and preparation. Using the output 
devices, the intended and calculated results can be acquired when the processing and handling 
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are completed. An input device transmits data to a computer and allows you to communicate 
with it and control it. 
Different Input Devices  
1. Keyboard: For entering data into a computer, the keyboard is the most common and 
commonly used input device. It contains various keys for entering letters, numbers, characters. 
Although there are some additional keys for completing various activities, the keyboard layout is 
identical to that of a standard typewriter. It is generally available in two different sizes: 84 keys 
or 101/102 keys and for Windows and the Internet, it is also available with 104 keys or 108 keys. 
It is connected to a computer system with the help of a USB or a Bluetooth device.  
The keys on the keyboard are: 

 Numeric Keys: These keys are used to enter numeric data and move the cursor. It is 
typically made up of 17 keys. 

 Keyboard Shortcuts: These keys include the letter keys (A-Z) and the number keys 
(09). 

 Control Keys: The pointer and the screen are controlled by these keys. It comes with 
four directional arrow keys. Control keys include Home, End, Insert, Alternate(Alt), 
Delete, Control(Ctrl), and Escape. 

 Special Keys: Enter, Shift, Caps Lock, NumLk, Tab, and Print Screen are some of the 
special function keys on the keyboard. 

 Function Keys: The 12 keys from F1 to F12 are on the topmost row of the keyboard. 
Type of keyboard: 
Generally, the keyboard is of three types: 

 QWERTY Keyboard 
 AZERTY Keyboard 
 DVORAK Keyboard 

Characteristics of Keyboard : 
 The keyboard has various functions keys for a different purpose 
 Instead of using the mouse, we can utilize the arrow keys on the keyboard to do the same 

purpose as the mouse. 
 The main keyboard, cursor keys, numeric keypad, and function keys are the four primary 

components of a keyboard. 
 Keyboards are more affordable. 

 
2. Mouse: The mouse is the most used pointing device. While clicking and dragging, the mouse 
moves a little cursor across the screen. If you let off of the mouse, the cursor will come to a halt. 
You must move the mouse for the computer to move; it will not move on its own. As a result, it’s 
a device that accepts input. Or we can say that a mouse is an input device that allows you to 
control the coordinates and movement of the on-screen cursor/pointer by moving the mouse on a 
flat surface. The left mouse button can be used to pick or move items, while the right mouse 
button displays additional menus when clicked. It was invented in 1963 by Douglas C. 
Engelbart.  
Types of mouse:  
Generally, the mouse is of four types: 

 Trackball Mouse 
 Mechanical Mouse 
 Optical Mouse 
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 Wireless Mouse 
Characteristics of the mouse: 

 A mouse is used to move the cursor on the screen in the desired direction. 
 A mouse allows users to choose files, folders, or multiple files or text or, all at once. 
 Hover over any object with the mouse pointer. 
 A mouse can be used to open a file, folder, etc. You must first move your pointer to a 

file, folder, and then double-click on it to open or execute. 
 
3. Joystick: A pointing device used to move the cursor around the screen is the joystick. Both 
the bottom and top ends of the stick have a spherical ball affixed to them. A socket contains the 
lower spherical ball. You can adjust the joystick in all directions. Trackballs became quite 
popular in laptops and PCs since they fit neatly inside the case and take up less room when in 
use. They are more precise and long-lasting than a mouse, which is why they are still utilized. It 
is invented by C.B.Mirick.  
Characteristics of Joystick: 

 It’s utilized to regulate the cursor’s position across a display screen. 
 It’s utilized in computer games to move the characters and symbols around. 
 It commonly features one or more push buttons, the condition of which can be controlled 

by the computer as well. 
 
4. Light Pen: A light pen is a pointing device that has the appearance of a pen. It can be used to 
draw on the monitor screen or to pick a menu item. In a small tube, a photocell and an optical 
system are housed. The photocell sensor element determines the screen location and sends a 
signal to the CPU when the tip of a light pen is moved across a monitor screen while the pen 
button is pressed. 
Characteristics of the light pen: 

 When drawing graphics, a light pen comes in very handy. 
 Objects on the display screen are selected with a light pen. 

 
5. Scanner: A scanner is a type of input device that works in the same way as a photocopier. It’s 
used when there’s data on paper that needs to be transferred to the computer’s hard disc for 
further processing. The scanner collects images from the source and translates them to a digital 
version that can be saved on the hard disks. These graphics can be changed before they are 
printed. 
Types of Scanner: 
Generally, the scanner is of five types:  

 Flatbed Scanner 
 Handheld Scanner 
 Sheetfed Scanner 
 Drum Scanner 
 Photo Scanner 

Characteristics of Scanner: 
 You can scan film negatives via a scanner if there is a transparent media adaptor. 
 A scanner may also scan low-quality or non-standard-weight paper. 
 The scanners are adaptable, allowing you to scan a wide range of items regardless of their 

size. You can scan small items as well as large documents if you can locate them. 
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6. OCR: OCR stands for “Optical Character Recognition” in its full form. OCR is a computer 
reading technique that reads numbers, characters, and symbols. OCR is a technique for 
recognizing text in documents that have been scanned into digital form. Optical character 
recognition (OCR) refers to a device that reads printed text. Character by character, OCR scans 
the text, converts it to a machine-readable code, and saves it into the memory of the system. 
OCR also functions as a scanner, scanning documents, photos, images, and handwritten text and 
storing the information in memory, which may then be compared to previously stored data. 
Characteristics of OCR: 

 The technology offers a complete solution for form processing and document capture. 
 It has capabilities for defining shapes, scanning, image pre-processing, and identification. 

7. Barcode Reader: A bar code reader is a device that reads bar-coded data (data that is 
represented by light and dark lines). To label things, number books, and so on, bar-coded data is 
often utilized. It could be a standalone scanner or a component of one. A barcode reader is a 
device that reads barcodes and extracts data from them. The code bar is used to read the bar code 
printed on any goods. By impacting light beams on barcode lines, a barcode reader identifies 
existing data in barcodes. 
Characteristics of Barcode Reader: 

 When a card is inserted, auto-start barcode scanners begin scanning immediately. 
 Reading indicators give the user confirms that the card has been swiped correctly. 
 It’s simple to use, simply hold your phone up to the code and scan it. 

 
8. Web Camera: A webcam is an input device since it records a video image of the scene in 
front of it. It can either be incorporated inside the computer (for example, a laptop) or connected 
via USB. A webcam is a small digital video camera that is connected to a computer. Because it 
can capture pictures and record video, it’s also known as a web camera. 
 
 
Characteristics of Web Camera: 

 Webcams are used to allow individuals to see one other while chatting online. This is 
formally referred to as ‘teleconferencing’. 

 Because webcams can take a picture only if movement is detected in the scene in front of 
them, they are commonly utilized in burglar alarms and other security systems. 

 Hundreds of webcams can be found all around the world, each pointing to a fascinating 
scene such as the exterior view of a facility in the Arctic or Niagara Falls. The webcam is 
connected to a computer that regularly sends an image to an internet server. After that, 
people connect to the server to view the most recent image. 

 
9. Graphic Tablet: A graphics tablet, also known as a digitizing tablet, is a computer input 
device that allows users to draw drawings and graphics by hand, much like they would with a 
pencil and paper. A graphics tablet is a flat surface on which the user can “draw” a picture with 
the help of an attached stylus, which is a pen-like drawing device. 
Characteristics of a Graphics Tablet: 

 The graphics tablet is a pressure-sensitive tablet that is controlled by a pen. 
 Drawing, writing, inserting, etc. can be done with the pen. 
 It provides more precision and the ability to monitor (than a touchscreen). 
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10. Digital Camera: Digital camera is a device that takes photographs as input. Images are 
saved on memory cards as data. It comes with an LCD display that allows users to view and 
review photographs. A digital camera contains photosensors that record the light that enters into 
the camera lens. So, when the light strikes the photosensors, they return the electric current and 
this electric current is used to create images.  
Characteristics of Digital Camera: 

 Users can immediately examine images and movies on the LCD screen. 
 All the photos can be stored in the storage device. 
 Users can select and choose the images they want to develop. 
 Easily portable & takes less space. 

 
Output Devices, 

Any peripheral that accepts data from a computer and prints, projects, or reproduces it is known 
as an output device. The output may be audio, video, hard copy – printed paper, etc. Output 
devices convert the computer data to human understandable form.  
We give input to the computer using input devices and the computer performs operations on the 
data and displays the output to the user using the output device.  
Output Devices 
The various output devices are:  
1. Monitor  
A computer’s principal output device is a monitor, often known as a Visual Display Unit (VDU). 
It displays the processed data like text, images, videos, audios, etc. It makes images by arranging 
microscopic dots in a rectangular pattern, known as pixels. The sharpness of an image is 
determined by the number of pixels. There are two types of monitor viewing screens:  
(1) Cathode-Ray Tube (CRT): This type of monitor is based on a cathode ray tube. In which 
the cathode ray tube generates a beam of electrons with the help of electron guns they strike on 
the inner surface of phosphorescent of the screen to generate images. The CRT monitor holds 
millions of phosphorus dotes in three different colors, i.e., red, blue, and green. These dots glow 
when the beam struck on them and create an image. The main parts of the CRT monitor are the 
electron gun, fluorescent screen, glass envelope, deflection plate assembly, and base. 
Characteristics of Monitor: 

 Resolution pixels: Pixels are the smallest element of any image 
 Size: The size of the monitor – The diagonal measurement of a desktop screen is 

typically 14 to 25 inches. 
 Refresh Rate: Total number of times per second that an image on a display is repainted or 

refreshed. 
(2) Display on a Flat Panel Monitor with a Cathode-Ray Tube (CRT): A flat-panel display is 
a type of video display with less volume, weight, and power consumption than a CRT. They can 
be put on the wrist or hang on the wall. Calculators, video games, monitors, laptop computers, 
and graphical displays all use flat-panel displays. 
 
(3) Plasma Monitor: It is also a flat panel display but it is based on plasma display technology. 
In a plasma monitor, a small cell is present in between two glass surfaces and these cells contain 
a solution of noble gases and mercury. So when the electricity supply on the gas present in the 
cell converts into plasma and produces UV light that creates an image. It is much better than an 
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LCD monitor. The resolution of this monitor is also high up to 1920 x 1920. It has a good 
contrast ratio, high refresh rate, etc.  
2. Printer 
Printers are information output devices that allow you to print data on paper. Or in other words, 
it is an output device that creates a hard copy of the processed data or information. Printers are 
divided into two categories:  
(1) Impact Printer: In impact printers, characters are printed on the ribbon, which is then 
smashed on the paper. Or we can say that such type of printer uses a print head or hammer to 
print the data on the paper. Here to print the paper the hammer or print head strikes an ink ribbon 
against the paper and the character starts printing. Some of the types of impact printers are: 

 Dot matrix printer 
 Daisy wheel printer 
 Line printer 
 Chain printer 

Impact printers have the following characteristics:  
 Extremely low consumable costs. 
 Fairly noisy 
 It’s perfect for large-scale printing because of its inexpensive cost. 
 Physical contact with the paper is required to form an image. 

(2) Non-Impact Printers: Non-impact printers print characters without the use of a ribbon. 
These printers are often known as Page Printers because they print a full page at a time. Some of 
the types of non-impact printers are: 

 Laser printer 
 Inkjet printer 

Non-impact printers have the following characteristics:  
 Quicker 
 They don’t produce much noise. 
 Superior quality 
 Supports a wide range of fonts and character sizes 

 
3. Plotter  
A plotter is a device that prints high-quality graphics in a variety of color formats. It works in a 
similar way to a printer, although it has more advanced features. It is used to print large maps, 
architectural drawings, large-format printing, and create pictures, 3D postcards, advertising 
signs, charts, and various designs of the internal structure of building machines, as well as create 
pictures, 3D postcards, advertising signs, charts, and various designs of the internal structure of 
building machines. 
Characteristics of Plotter: 

 Large size prints can be taken via plotters 
 It is slow & expensive. 

 
4. Projector  
A projector is a device that allows users to project their output onto a large area, such as a screen 
or a wall. It can be used to project the output of a computer and other devices onto a screen. It 
magnifies texts, photos, and movies using light and lenses. As a result, it’s an excellent output 
device for giving presentations or teaching big groups of people. 
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Characteristics of Projector: 
 They are lightweight, and one person can easily take them out of the box, connect them, 

and hang an image on the wall. 
 Projectors can be the most cost-effective option for large-screen video in your home. 
 A small projector mounted on a back shelf or bookcase, or mounted on the ceiling, takes 

up no area on the floor. It is barely visible when it is not in use. 
 
5. Speakers  
Speakers are connected to computers to allow sound to be output. For the working of speakers, 
sound cards are required. From simple two-speaker output devices to surround-sound multi-
channel sets, speakers come in a variety of shapes and sizes. They take audio input from the 
computer’s sound card and output sound waves as audio output. 
Characteristics of Speakers: 

 Speakers are available in a wide range of qualities and prices. 
 Small, plastic computer speakers with low sound quality are often included with 

computer systems. 
 
6. Headphones 
To hear the sound, use earbuds with your PC, laptop, or smartphone. It enables you to hear the 
sound without causing any inconvenience to others. To translate electronic signals into sounds 
without causing inconvenience to others. They can be wired or wireless and can be connected to 
computers, laptops, mobile phones, etc. They are connected with the devices via Bluetooth. 
Characteristics of Headphones: 

 Stereo phones and headsets are other names for them. 
 Earphones or earbuds are the names for the in-ear variants. 
 The term headset denotes a combination of headphones and a microphone used for two-

way communication, such as using a telephone. 
 
7. Sound Card 
Sound cards are computer output devices that are inserted into the computer. A sound card, 
either external or internal, is required to produce sound on any computer (built-in). An external 
sound card enables for better overall sound generation and is required for wide and clear sound 
recording, as well as sound without noise and interference. 
Characteristics of Sound Card: 

 To listen speakers or headphones, to play games, watch movies, listen to music, or use 
audio and video conferencing, we use an internal sound card. 

 Frequency is a sound card parameter that represents the number of signals the card 
processes per unit of time. The frequency is expressed in hertz. The frequency of most 
sound cards is 96 or 192 kHz. 

 Synthesizers and a variety of electronic musical instruments, such as drums and 
keyboards, can be connected to your computer using a sound card with standard Musical 
Instrument Digital Interface (MIDI) connections. 

 
8. Video Card 
An extension card via which a computer can transfer graphical data to a video display device like 
a TV, projector, or monitor. It processes photos and video, as well as other functions that the 



These notes are edited for Academic Purpose and Private Circulation Only 

Information and Communication Technology 
Ph.D Cell Loknayak Bapuji Aney Mahila Mahavidyalaya, Yavatmal  18 

CPU generally does. As they have a good processing capability and video RAM, Gamers utilize 
video cards. 
Characteristics of Video Card: 

 Heat sinks are required for video cards with high performance as they generate a lot of 
heat. 

 Also known as graphics card & require software installation in addition to the hardware. 
 When working with huge files, video cards supply a significant quantity of video-only 

memory that frees up CPU resources, allowing the system to run more effectively. 
 
9. Speech synthesizer 
A speech synthesizer is a computerized device that takes in data, interprets it, and generates 
audible words. It might be a computer card, a box connected by a cable, or software that works 
with the computer’s sound card. 
Characteristics of speech synthesizer: 

 Any text, predetermined input can be translated into audible speech. 
 For people who are unable to talk or have impaired vision, it can provide digital verbal 

communication. 
 It takes in data, interprets it, and generates sound output. 

 
10. GPS 
The Global Positioning System (GPS) is a radio-based satellite navigation system that uses radio 
signals to pinpoint a specific position. The sender sends a radio signal to satellites, which collect 
data such as time, location, speed, and other variables and deliver it to the reception computer for 
analysis. Because this processed data can be evaluated to obtain information, it is considered as 
an output device. 
Characteristics of GPS: 

 GPS satellites constantly communicate their position and time. 
 Solar storms, high storm cover, and other factors impair GPS equipment. 
 The Global Positioning System (GPS) is based on the mathematical idea of ‘trilateration.’ 
 The GPS works independently of telephonic or internet reception & does not need the 

user to send any data, however, to improve accuracy both technologies can be used. 
 
 
 

Storage Devices. 
A storage unit is a part of the computer system which is employed to store the information and 
instructions to be processed. A storage device is an integral part of the computer hardware which 
stores information/data to process the result of any computational work. Without a storage 
device, a computer would not be able to run or even boot up. Or in other words, we can say that a 
storage device is hardware that is used for storing, porting, or extracting data files. It can also 
store information/data both temporarily and permanently. Computer storage is of two types:  

 Primary Storage Devices: It is also known as internal memory and main memory. This 
is a section of the CPU that holds program instructions, input data, and intermediate 
results. It is generally smaller in size. RAM (Random Access Memory) and ROM (Read 
Only Memory) are examples of primary storage. 
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 Secondary Storage Devices: Secondary storage is a memory that is stored external to the 
computer.  It is mainly used for the permanent and long-term storage of programs and 
data. Hard Disk, CD, DVD, Pen/Flash drive, SSD, etc, are examples of secondary 
storage. 

 
 
Storage Devices 
Now we will discuss different types of storage devices available in the market. These storage 
devices have their own specification and use. Some of the commonly used storage devices are: 
1. Primary storage devices 
(i) RAM: It stands for Random Access Memory. It is used to store information that is used 
immediately or we can say that it is a temporary memory. Computers bring the software installed 
on a hard disk to RAM to process it and to be used by the user. Once, the computer is turned off, 
the data is deleted. With the help of RAM, computers can perform multiple tasks like loading 
applications, browsing the web, editing a spreadsheet, experiencing the newest game, etc. It 
allows you to modify quickly among these tasks, remembering where you’re in one task once 
you switch to a different task. It is also used to load and run applications, like your spreadsheet 
program, answer commands, like all edits you made within the spreadsheet, or toggle between 
multiple programs, like once you left the spreadsheet to see the email. Memory is nearly always 
being actively employed by your computer. It ranges from 1GB – 32GB/64GB depending upon 
the specifications. There are different types of RAM, although they all serve the same purpose, 
the most common ones are :  

 SRAM: It stands for Static Random Access Memory. It consists of circuits that retain 
stored information as long as the power is supply is on. It is also known as volatile 
memory. It is used to build Cache memory. The access time of SRAM is lower and it is 
much faster as compared to DRAM but in terms of cost, it is costly as compared to 
DRAM. 

 DRAM: It stands for Dynamic Random Access Memory. It is used to stores binary bits 
in the form of electrical charges that are applied to capacitors. The access time of DRAM 
is slower as compare to SRAM but it is cheaper than SRAM and has a high packaging 
density. 

 SDRAM: It stands for Synchronous Dynamic Random Access Memory. It is faster than 
DRAM. It is widely used in computers and others. After SDRAM was introduced, the 
upgraded version of double data rate RAM, i.e., DDR1, DDR2, DDR3, and DDR4 was 
entered into the market and widely used in home/office desktops and laptops. 

(ii) ROM: It stands for Read-Only Memory. The data written or stored in these devices are non-
volatile, i.e, once the data is stored in the memory cannot be modified or deleted. The memory 
from which will only read but cannot write it. This type of memory is non-volatile. The 
information is stored permanently during manufacture only once. ROM stores instructions that 
are used to start a computer. This operation is referred to as bootstrap. It is also used in other 
electronic items like washers and microwaves. ROM chips can only store few megabytes (MB) 
of data, which ranges between 4 and 8 MB per ROM chip. There are two types of ROM:  

 PROM: PROM is Programmable Read-Only Memory. These are ROMs that can be 
programmed. A special PROM programmer is employed to enter the program on the 
PROM. Once the chip has been programmed, information on the PROM can’t be altered. 
PROM is non-volatile, that is data is not lost when power is switched off. 
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 EPROM: Another sort of memory is that the Erasable Programmable Read-Only 
Memory. It is possible to erase the info which has been previously stored on an EPROM 
and write new data onto the chip. 

2. Magnetic Storage Devices 
(i) Floppy Disk: It is also known as a floppy diskette. It is generally used on a personal 
computer to store data externally. A Floppy disk is made up of a plastic cartridge and secures 
with a protective case. Nowadays floppy disk is replaced by new and effective storage devices 
like USB, etc. 
(ii) Hard Disk: It is a storage device (HDD) that stores and retrieves data using magnetic 
storage. It is a non-volatile storage device that can be modified or deleted n number of times 
without any problem. Most of the computers and laptops have HDDs as their secondary storage 
device. It is actually a set of stacked disks, just like phonograph records. In every hard disk, the 
data is recorded electromagnetically in the concentric circles or we can say track present on the 
hard disk, and with the help of a head just like a phonograph arm(but fixed in a position) to read 
the information present on the track. The read-write speed of HDDs is not so fast but decent. It 
ranges from a few GBs to a few and more TB. 
(iii) Magnetic Card: It is a card in which data is stored by modifying or rearranging the 
magnetism of tiny iron-based magnetic particles present on the band of the card. It is also known 
as a swipe card. It is used like a passcode(to enter into house or hotel room), credit card, identity 
card, etc.  
(iv) Tape Cassette: It is also known as a music cassette. It is a rectangular flat container in 
which the data is stored in an analog magnetic tape. It is generally used to store audio 
recordings.  
(v) SuperDisk: It is also called LS-240 and LS-120. It is introduced by Imation corporation and 
it is popular with OEM computers. It can store data up to 240 MB.  
3. Flash memory Devices 
It is a cheaper and portable storage device. It is the most commonly used device to store data 
because is more reliable and efficient as compare to other storage devices. Some of the 
commonly used flash memory devices are: 
(i) Pen Drive: It is also known as a USB flash drive that includes flash memory with an 
integrated USB interface. We can directly connect these devices to our computers and laptops 
and read/write data into them in a much faster and efficient way. These devices are very portable. 
It ranges from 1GB to 256GB generally. 
(ii) SSD: It stands for Solid State Drive, a mass storage device like HDDs. It is more durable 
because it does not contain optical disks inside like hard disks. It needs less power as compared 
to hard disks, is lightweight, and has 10x faster read and write speed as compared to hard disks. 
But, these are costly as well. While SSDs serve an equivalent function as hard drives, their 
internal components are much different. Unlike hard drives, SSDs don’t have any moving parts 
and thus they’re called solid-state drives. Instead of storing data on magnetic platters, SSDs store 
data using non-volatile storage. Since SSDs haven’t any moving parts, they do not need to “spin 
up”. It ranges from 150GB to a few and more TB. 
(iii) SD Card: It is known as a Secure Digital Card. It is generally used with electronic devices 
like phones, digital cameras, etc. to store larger data. It is portable and the size of the SD card is 
also small so that it can easily fit into electronic devices. It is available in different sizes like 
2GB, 4GB, 8GB, etc. 
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(iv) Memory Card: It is generally used in digital cameras. printers, game consoles, etc. It is also 
used to store large amounts of data and is available in different sizes. To run a memory card on a 
computer you require a separate memory card reader.   
(v) Multimedia Card: It is also known as MMC. It is an integrated circuit that is generally used 
in-car radios, digital cameras, etc. It is an external device to store data/information. 
4. Optical Storage Devices 
Optical Storage Devices is also a secondary storage device. It is a removable storage device. 
Following are some optical storage devices: 
(i) CD: It is known as Compact Disc. It contains tracks and sectors on its surface to store data. It 
is made up of polycarbonate plastic and is circular in shape. CD can store data up to 700MB. It is 
of two types: 

 CD-R: It stands for Compact Disc read-only. In this type of CD, once the data is written 
can not be erased. It is read-only. 

 CD-RW: It stands for Compact Disc read Write. In this type of CD, you can easily write 
or erase data multiple times. 

(ii) DVD: It is known as Digital Versatile Disc. DVDs are circular flat optical discs used to store 
data. It comes in two different sizes one is 4.7GB single-layer discs and another one is 8.5GB 
double-layer discs. DVDs look like CDs but the storage capacity of DVDs is more than as 
compared to CDs. It is of two types: 

 DVD-R: It stands for Digital Versatile Disc read-only. In this type of DVD, once the data 
is written can not be erased. It is read-only. It is generally used to write movies, etc. 

 DVD-RW: It stands for Digital Versatile Disc read Write. In this type of DVD, you can 
easily write or erase data multiple times. 

(iii) Blu-ray Disc: It is just like CD and DVD but the storage capacity of blu ray is up to 25GB. 
To run a Blu-ray disc you need a separate Blu-ray reader. This Blu-ray technology is used to read 
a disc from a blue-violet laser due to which the information is stored in greater density with a 
longer wavelength. 
 
5. Cloud and Virtual Storage 
Nowadays, secondary memory has been upgraded to virtual or cloud storage devices. We can 
store our files and other stuff in the cloud and the data is stored for as long as we pay for the 
cloud storage. There are many companies that provide cloud services largely Google, Amazon, 
Microsoft, etc. We can pay the rent for the amount of space we need and we get multiple benefits 
out of it. Though it is actually being stored in a physical device located in the data centers of the 
service provider, the user doesn’t interact with the physical device and its maintenance. For 
example, Amazon Web Services offers AWS S3 as a type of storage where users can store data 
virtually instead of being stored in physical hard drive devices. These sorts of innovations 
represent the frontier of where storage media goes. 
 
 
Categories of Software,  
History of software 
The term software was not used until the late 1950s. During this time, although different types of 
programming software were being created, they were typically not commercially available. 
Consequently, users -- mostly scientists and large enterprises -- often had to write their own 
software. 
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The following is a brief timeline of the history of software: 
 June 21, 1948. Tom Kilburn, a computer scientist, writes the world's first piece of 

software for the Manchester Baby computer at the University of Manchester in England. 
 Early 1950s. General Motors creates the first OS, for the IBM 701 Electronic Data 

Processing Machine. It is called General Motors Operating System, or GM OS. 
 1958. Statistician John Tukey coins the word software in an article about computer 

programming. 
 Late 1960s. Floppy disks are introduced and are used in the 1980s and 1990s to distribute 

software. 
 Nov. 3, 1971. AT&T releases the first edition of the Unix OS. 
 1977. Apple releases the Apple II and consumer software takes off. 
 1979. VisiCorp releases VisiCalc for the Apple II, the first spreadsheet software for 

personal computers. 
 1981. Microsoft releases MS-DOS, the OS on which many of the early IBM computers 

ran. IBM begins selling software, and commercial software becomes available to the 
average consumer. 

 1980s. Hard drives become standard on PCs, and manufacturers start bundling software 
in computers. 

 1983. The free software movement is launched with Richard Stallman's GNU (GNU is 
not Unix) Linux project to create a Unix-like OS with source code that can be freely 
copied, modified and distributed. 

 1984. Mac OS is released to run Apple's Macintosh line. 
 Mid-1980s. Key software applications, including AutoDesk AutoCAD, Microsoft Word 

and Microsoft Excel, are released. 
 1985. Microsoft Windows 1.0 is released. 
 1989. CD-ROMs become standard and hold much more data than floppy disks. Large 

software programs can be distributed quickly, easily and relatively inexpensively. 
 1991. The Linux kernel, the basis for the open source Linux OS, is released. 
 1997. DVDs are introduced and able to hold more data than CDs, making it possible to 

put bundles of programs, such as the Microsoft Office Suite, onto one disk. 
 1999. Salesforce.com uses cloud computing to pioneer software delivery over the 

internet. 
 2000. The term software as a service (SaaS) comes into vogue. 
 2007. IPhone is launched and mobile applications begin to take hold. 
 2010 to the present. DVDs are becoming obsolete as users buy and download software 

from the internet and the cloud. Vendors move to subscription-based models and SaaS 
has become common. 

 
Different Types of Software 
Typically, there are two major classifications of software, namely System Software and 
Application Software. 
1. System Software 
A system software aids the user and the hardware to function and interact with each other. 
Basically, it is a software to manage computer hardware behavior so as to provide basic 
functionalities that are required by the user. In simple words, we can say that system software is 
an intermediator or a middle layer between the user and the hardware. These computer software 
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sanction a platform or environment for the other software to work in. This is the reason why 
system software is very important in managing the entire computer system. When you first turn 
on the computer, it is the system software that gets initialized and gets loaded in the memory of 
the system. The system software runs in the background and is not used by the end-users. This is 
the reason why system software is also known as ‘low-level software’. 
 
Some common system software examples are: 

 Operating System: It is the most prominent example of System Software. It is a collection 
of software that handles resources and provides general services for the other applications 
that run over them. Although each Operating System is different, most of them provide a 
Graphical User Interface through which a user can manage the files and folders and 
perform other tasks. Every device, whether a desktop, laptop or mobile phone requires an 
operating system to provide the basic functionality to it. As an OS essentially determines 
how a user interacts with the system, therefore many users prefer to use one specific OS 
for their device. There are various types of operating system such as real-time, embedded, 
distributed, multiuser, single-user, internet, mobile, and many more. It is important to 
consider the hardware specifications before choosing an operating system. Some 
examples of Operating systems given below: 

  
o Android 
o CentOS 
o iOS 
o Linux 
o Mac OS 
o MS Windows 
o Ubuntu 
o Unix 

 Device Drivers: It is a type of software that controls particular hardware which is 
attached to the system. Hardware devices that need a driver to connect to a system 
include displays, sound cards, printers, mice and hard disks. Further, there are two types 
of device drivers: Kernel Device Drivers and User Device Driver. Some examples of 
device drivers are: 

  
o BIOS Driver 
o Display Drivers 
o Motherboard Drivers 
o Printer Drivers 
o ROM Drivers 
o Sound card Driver 
o USB Drivers 
o USB Drivers 
o VGA Drivers 
o VGA Drivers 
o Virtual Device Drivers 

 Firmware: Firmware is the permanent software that is embedded into a read-only 
memory. It is a set of instructions permanently stored on a hardware device. It provides 
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essential information regarding how the device interacts with other hardware. Firmware 
can be considered as ‘semi-permanent’ as it remains permanent unless it is updated using 
a firmware updater. Some examples of firmware are: 

o BIOS 
o Computer Peripherals 
o Consumer Applications 
o Embedded Systems 
o UEFI 

 Programming Language Translators: These are mediator programs on which software 
programs rely to translate high-level language code to simpler machine-level code. 
Besides simplifying the code, the translators also do the following : 

o Assign data storage 
o Enlist source code as well as program details 
o Offer diagnostic reports 
o Rectify system errors during the runtime 
o Examples of Programming Language Translators are Interpreter, Compiler and 

Assemblers. 
 Utility: Utility software is designed to aid in analyzing, optimizing, configuring and 

maintaining a computer system. It supports the computer infrastructure. This software 
focuses on how an OS functions and then accordingly it decides its trajectory to 
smoothen the functioning of the system. Softwares like antiviruses, disk cleanup & 
management tools, compression tools, defragmenters, etc are all utility tools. Some 
examples of utility tools are: 

  
o Avast Antivirus 
o Directory Opus 
o McAfee Antivirus 
o Piriform CCleaner 
o Razer Cortex 
o Windows File Explorer 
o WinRAR 
o WinZip 

2. Application Software 
Application Software, also known as end-user programs or productivity programs are software 
that helps the user in completing tasks such as doing online research, jotting down notes, setting 
an alarm, designing graphics, keeping an account log, doing calculations or even playing games. 
They lie above the system software. Unlike system software, they are used by the end-user and 
are specific in their functionality or tasks and do the job that they are designed to do. For 
example, a browser is an application designed specifically for browsing the internet or MS 
Powerpoint is an application used specifically for making presentations. Application Software or 
simply apps can also be referred to as non-essential software as their requirement is highly 
subjective and their absence does not affect the functioning of the system. All the apps that we 
see on our mobile phones are also examples of Application Software. There is certain software 
that is exclusively made for app development like Meteor and Flutter. These are examples of 
Application software too. 
There are various types of application software: 
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 Word Processors: These applications for documentation. Along with that it also helps I 
storing, formatting and printing of these documents. Some examples of word processors 
are: 

  
o Abiword 
o Apple iWork- Pages 
o Corel WordPerfect 
o Google Docs 
o MS Word 

 Database Software: This software is used to create and manage a database. It is also 
known as the Database Management System or DBMS. They help with the organization 
of data. Some examples of DBMS are: 

  
o Clipper 
o dBase 
o FileMaker 
o FoxPro 
o MS Access 
o MySQL 

 Multimedia Software: It is the software that is able to play, create or record images, audio 
or video files. They are used for video editing, animation, graphics, and image editing, 
Some examples of Multimedia Software are: 

  
o Adobe Photoshop 
o Inkscape 
o Media Monkey 
o Picasa 
o VLC Media Player 
o Windows Media Player 
o Windows Movie Maker 

 Education and Reference Software: These types of software are specifically designed to 
facilitate learning on a particular subject. There are various kinds of tutorial software that 
fall under this category. They are also termed as academic software. Some examples are: 

  
o Delta Drawing 
o GCompris 
o Jumpstart titles 
o KidPix 
o MindPlay 
o Tux Paint 

 Graphics Software: As the name suggests, Graphics Software has been devised to work 
with graphics as it helps the user to edit or make changes in visual data or images. It 
comprises of picture editors and illustration software. Some examples are: 

  
o Adobe Photoshop 
o Autodesk Maya 
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o Blender 
o Carrara 
o CorelDRAW 
o GIMP 
o Modo 
o PaintShop Pro 

 Web Browsers: These applications are used to browse the
locating and retrieving data across the web. Some examples of web browsers are:

  
o Google Chrome 
o Internet Explorer 
o Microsoft Edge 
o Mozilla Firefox 
o Opera 
o Safari 
o UC Browser 

Other than these, all the software that serves a 
Application Software. 
 
 
Computer Network: Basic hardware and
Open system:  
A system which is connected to the network and is ready for communication.
Closed system:  
A system which is not connected to the network and can’t be communicated with.
Computer Network:  
An interconnection of multiple devices, also known as hosts, that are connected using multiple 
paths for the purpose of sending/receiving data or media. Computer networks can a
multiple devices/mediums which help in the communication between two different devices; 
these are known as Network devices
bridges.  
  

Network Topology:  
The layout arrangement of the different devices in a network. Common examples include: Bus, 
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These applications are used to browse the internet. They help the user in 
locating and retrieving data across the web. Some examples of web browsers are:

 

Other than these, all the software that serves a specific purpose fall under the category of 

Computer Network: Basic hardware and terminology in networks,  

A system which is connected to the network and is ready for communication.  

ot connected to the network and can’t be communicated with.

An interconnection of multiple devices, also known as hosts, that are connected using multiple 
paths for the purpose of sending/receiving data or media. Computer networks can a
multiple devices/mediums which help in the communication between two different devices; 

Network devices and include things such as routers, switches, hubs, and 

 

The layout arrangement of the different devices in a network. Common examples include: Bus, 
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internet. They help the user in 
locating and retrieving data across the web. Some examples of web browsers are: 

specific purpose fall under the category of 

ot connected to the network and can’t be communicated with.  

An interconnection of multiple devices, also known as hosts, that are connected using multiple 
paths for the purpose of sending/receiving data or media. Computer networks can also include 
multiple devices/mediums which help in the communication between two different devices; 

and include things such as routers, switches, hubs, and 

The layout arrangement of the different devices in a network. Common examples include: Bus, 
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Star, Mesh, Ring, and Daisy chain.
  

OSI:  
OSI stands for Open Systems Interconnection
for communications protocols and also the functionalities of each layer.
Protocol:  
A protocol is the set of rules or algorithms which define the way how two entities can 
communicate across the network and there exists different protocol defined at each layer of the 
OSI model. Few of such protocols are TCP, IP, UDP, ARP, DHCP, FTP and so on.
UNIQUE IDENTIFIERS OF NETWORK
Host name:  
Each device in the network is associated with a unique device name known as Hostname.
Type “hostname” in the command prompt(Administrator Mode) an
the hostname of your machine.  
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Star, Mesh, Ring, and Daisy chain.  

 

Open Systems Interconnection. It is a reference model that specifies standards 
cols and also the functionalities of each layer.  

A protocol is the set of rules or algorithms which define the way how two entities can 
communicate across the network and there exists different protocol defined at each layer of the 

ew of such protocols are TCP, IP, UDP, ARP, DHCP, FTP and so on.
UNIQUE IDENTIFIERS OF NETWORK  

Each device in the network is associated with a unique device name known as Hostname.
Type “hostname” in the command prompt(Administrator Mode) and press ‘Enter’, this displays 
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. It is a reference model that specifies standards 

A protocol is the set of rules or algorithms which define the way how two entities can 
communicate across the network and there exists different protocol defined at each layer of the 

ew of such protocols are TCP, IP, UDP, ARP, DHCP, FTP and so on.  

Each device in the network is associated with a unique device name known as Hostname.  
d press ‘Enter’, this displays 
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IP Address (Internet Protocol address):
Also known as the Logical Address, the IP Address is the network address of the system across 
the network.  
To identify each device in the world
(IANA) assigns an IPV4 (Version 4) address as a unique identifier to each device on the 
Internet.  
The length of an IPv4 address is 32
an IPv6 address is 128-bits. 
Type “ipconfig” in the command prompt and press ‘Enter’, this gives us the IP address of the 
device.  
MAC Address (Media Access Control address):
Also known as physical address, the MAC Address is the unique identifier of each host and is
associated with its NIC (Network Interface Card).
A MAC address is assigned to the NIC at the time of manufacturing.
The length of the MAC address is : 12
Type “ipconfig/all” in the command prompt and press ‘Enter’, this gives 
Port:  
A port can be referred to as a logical channel through which data can be sent/received to an 
application. Any host may have multiple applications running, and each of these applications is 
identified using the port number on whi
A port number is a 16-bit integer, hence, we have 2
shown below:  
  
Port Types Range 

Well known Ports 0 – 1023 

Registered Ports 1024 – 49151

Ephemeral Ports 49152 – 65535

Number of ports: 65,536  
Range: 0 – 65535  
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IP Address (Internet Protocol address):  
Also known as the Logical Address, the IP Address is the network address of the system across 

To identify each device in the world-wide-web, the Internet Assigned Numbers Authority 
(IANA) assigns an IPV4 (Version 4) address as a unique identifier to each device on the 

The length of an IPv4 address is 32-bits, hence, we have 232 IP addresses available. The length of 

Type “ipconfig” in the command prompt and press ‘Enter’, this gives us the IP address of the 

MAC Address (Media Access Control address):  
Also known as physical address, the MAC Address is the unique identifier of each host and is
associated with its NIC (Network Interface Card).  
A MAC address is assigned to the NIC at the time of manufacturing.  
The length of the MAC address is : 12-nibble/ 6 bytes/ 48 bits  
Type “ipconfig/all” in the command prompt and press ‘Enter’, this gives us the MAC address.

A port can be referred to as a logical channel through which data can be sent/received to an 
application. Any host may have multiple applications running, and each of these applications is 
identified using the port number on which they are running.  

bit integer, hence, we have 216 ports available which are categorized as 

 

49151 

65535 

Type “netstat 
command prompt and 
press ‘Enter’, this lists 
all the ports being 
used.  
  
 
Socket:
The unique 
combination of IP 
address and Port 
number together are 
termed as Socket.
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Also known as the Logical Address, the IP Address is the network address of the system across 

web, the Internet Assigned Numbers Authority 
(IANA) assigns an IPV4 (Version 4) address as a unique identifier to each device on the 

IP addresses available. The length of 

Type “ipconfig” in the command prompt and press ‘Enter’, this gives us the IP address of the 

Also known as physical address, the MAC Address is the unique identifier of each host and is 

us the MAC address.  

A port can be referred to as a logical channel through which data can be sent/received to an 
application. Any host may have multiple applications running, and each of these applications is 

ports available which are categorized as 

netstat -a” in the 
command prompt and 
press ‘Enter’, this lists 
all the ports being 

 

Socket:  
The unique 
combination of IP 
address and Port 
number together are 
termed as Socket.  



These notes are edited for Academic 

Information and Communication Technology
Ph.D Cell Loknayak Bapuji Aney Mahila Mahavidyalaya, Yavatmal 

Other related concepts  
DNS Server:  
DNS stands for Domain Name system
DNS is basically a server which translates web addresses or URLs (ex: www.google.com) into 
their corresponding IP addresses. We don’t have to remember all the IP addresses of each and 
every website.  
The command ‘nslookup’ gives you the IP address of the domain you are looking for. This also 
provides the information of our DNS Server.
  

ARP:  
ARP stands for Address Resolution Protocol
It is used to convert an IP address to its corresponding physical address(
ARP is used by the Data Link Layer to identify the MAC address of the Receiver’s machine.
RARP:  
RARP stands for Reverse Address Resolution Protocol
As the name suggests, it provides the IP address of the device given a physical add
But RARP has become obsolete since the time DHCP has come into the picture.
 
 
Classifications of Computer Networks, 
1. PERSONAL AREA NETWORK (PAN)
This is the smallest and most basic network that you’ll find. It’s meant to cover a very sma
(typically a single room or building). A PAN is most commonly used for one individual and to 
connect just a handful of devices such as a computer, smart phone, and printer. Probably the 
most well-known PAN technology is Bluetooth connection. So, ne
phone to your car to play music, you can thank your Personal Area Network!
2. LOCAL AREA NETWORK (LAN)
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Domain Name system.  
DNS is basically a server which translates web addresses or URLs (ex: www.google.com) into 
their corresponding IP addresses. We don’t have to remember all the IP addresses of each and 

’ gives you the IP address of the domain you are looking for. This also 
provides the information of our DNS Server.  

Address Resolution Protocol.  
It is used to convert an IP address to its corresponding physical address(i.e., MAC Address).
ARP is used by the Data Link Layer to identify the MAC address of the Receiver’s machine.

Reverse Address Resolution Protocol.  
As the name suggests, it provides the IP address of the device given a physical add
But RARP has become obsolete since the time DHCP has come into the picture. 

Classifications of Computer Networks,  
1. PERSONAL AREA NETWORK (PAN) 
This is the smallest and most basic network that you’ll find. It’s meant to cover a very sma
(typically a single room or building). A PAN is most commonly used for one individual and to 
connect just a handful of devices such as a computer, smart phone, and printer. Probably the 

known PAN technology is Bluetooth connection. So, next time you connect your 
phone to your car to play music, you can thank your Personal Area Network! 
2. LOCAL AREA NETWORK (LAN) 
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DNS is basically a server which translates web addresses or URLs (ex: www.google.com) into 
their corresponding IP addresses. We don’t have to remember all the IP addresses of each and 

’ gives you the IP address of the domain you are looking for. This also 

 

i.e., MAC Address).  
ARP is used by the Data Link Layer to identify the MAC address of the Receiver’s machine.  

As the name suggests, it provides the IP address of the device given a physical address as input. 
  

This is the smallest and most basic network that you’ll find. It’s meant to cover a very small area 
(typically a single room or building). A PAN is most commonly used for one individual and to 
connect just a handful of devices such as a computer, smart phone, and printer. Probably the 

xt time you connect your 
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This is an extremely common and well-known type of network. Just as the name suggests, a 
LAN connects a group of computers or devices together across a local area. This type of network 
can be utilized to connect devices throughout one building or even 2-3 buildings depending on 
the proximity to each other.  Whether your office location utilizes wired or wireless connection, 
it’s almost surely using a LAN connection. This brings us to the next type of network… 
3. WIRELESS LOCAL AREA NETWORK (WLAN) 
A WLAN is simply a LAN that does not rely on cables to connect to the network. So, when 
you’re using WiFi, you’re using a WLAN. WLANs are typically used in the same scenario as 
LANs, it just depends on whether you’d prefer an on premises or remote cloud solution (wires or 
wireless). 
4. METROPOLITAN AREA NETWORK (MAN) 
Larger than a LAN but smaller than a WAN, a MAN incorporates elements of both types of 
networks. It connects multiple LANs together and spans an entire geographical area such as a 
city or town (or sometimes a campus). Ownership and management can be handled by a single 
person, but it’s more likely done by a larger company or organization. 
5. WIDE AREA NETWORK (WAN) 
Like LANs, you very well may recognize the term “WAN.” WANs do the same thing as LANs 
but across a larger area while connecting more devices. Even when miles apart, a WAN can 
connect devices together remotely. In fact, the most basic example of a WAN is the Internet 
which connects computers and devices worldwide. Since it’s much larger, this type of network is 
typically maintained by multiple administrators and ownership is distributed across various 
organizations.  
6. STORAGE AREA NETWORK (SAN) 
A SAN is another type of LAN that’s designed to handle large data transfers and storage. This 
purpose of this network is to move larger, more complex storage resources away from the 
network into a separate, high-performance atmosphere. Doing this not only allows for easy 
retrieval and storage of the data but it also frees up space and improves overall performance of 
the original network. 
7. VIRTUAL PRIVATE NETWORK (VPN) 
The point of a VPN is to increase security and privacy while accessing a network. The VPN acts 
as a middleman between you and the network by encrypting your data and hiding your identity. 
This is a great option for sending and receiving sensitive information, however, using a VPN is 
ideal anytime you connect to the Internet. Anytime you’re on a public network, you run the risk 
of being targeted by a hacker, so using a VPN is you best bet at ensuring your cybersecurity. 
At Sierra Experts, we provide various networking services from planning and design to 
implementing and monitoring. After all, at the core of any successful business is a computer 
network that’s running at peak performance. Even if you think you have a high-functioning, 
reliable network, it couldn’t hurt to have us check it out. We provide services such as network 
mapping and penetration testing which can help provide insight on how your network is 
functioning and what can be improved. 
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The Internet,  
 

The Intranet and Extranet. 
 
S.NO Intranet Extranet 
1. Intranet is a tool for sharing 

information throughout the 
organization. 

Whereas Extranet is a tool for sharing information 
between the internal members and external 
members. 

2. Intranet is owned by a single 
organization. 

While Extranet is owned by either a single or a 
many organization. 

3. In intranet, security is 
implemented through a firewall. 

Whereas in this, security is implemented through a 
firewall in order to separate the extranet and the 
internet. 

4. Intranet is managed by an 
organization. 

Whereas Extranet is managed by many 
organizations. 

5. Intranet has a limited number of 
connected devices. 

Whereas in the extranet, connected devices are 
comparable with the intranet. 

6. Intranet is a private network type 
for an organization. 

While it is also a private network in which public 
network is used in order to share the information 
to the suppliers and customers. 

7. Intranet is used in order to get 
employee information, telephone 
directory etc. 

While It is used to check status, access data, send 
mail, place order etc. 

8. Intranet is the limited and 
compromised version of Extranet. 

While Extranet is the limited and compromised 
version of Internet. 

9. A particular organization is the 
regulating authority for intranet. 

While it is regulated by multiple organizations. 

10. It is accessible to only the 
members of organization. 

It is accessible to members of organization as well 
as external members with logins. 

11. It’s restricted area is upto an 
organization. 

It’s restricted area is upto an organization and 
some of its stakeholders. 

12. It is derived from Internet. It is derived from Intranet. 
13. Example: WIPRO using internal 

network for its business 
operations. 

Example: DELL and Intel using network for 
business related operations.  
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Unit II :INTRODUCTION TO OPERATING SYSTEM & WORD 
PROCESSING SOFTWARE 

(Latest Versions of the Operating System/ Word Processing Software are Recommended) 
 

Installing Windows,  
Each version of Microsoft Windows is installed on a computer using similar steps. While there 
are steps in the installation process that differ between versions of Windows, the following 
general steps and guidelines help you install Windows on your computer. 
Note 
If you're replacing the hard drive in your computer, you need to reinstall Windows again. 
 
If you're replacing the motherboard in your computer, you may need to purchase a new licensed 
copy of Windows and install it. Microsoft has designed current versions of Windows to be tied to 
the motherboard in the computer when Windows is installed. So if you change the motherboard, 
the existing license, or product key, may no longer be valid. 
 
Tip 
If you want to upgrade to a newer version of Windows on your computer, the steps on this 
page help you with the upgrade process. The Windows installation process should recognize if 
you have an older version of Windows already installed on the computer and ask if you want to 
upgrade or perform a fresh install. The upgrade process installs the newer Windows operating 
system files over the old ones and preserve your files. 
The steps below are for all recent versions of Windows, including Windows 98, Windows 
ME, Windows 2000, Windows XP, Windows Vista, Windows 7, Windows 8, Windows 10, 
and Windows 11. These steps even work for earlier versions (e.g., Windows 95) as long as you 
use the disc version. The floppy diskette version is similar, but it requires additional steps. 
 
Note 
The install guidelines for Windows for a server have additional steps based on the type of server 
and version of Windows. 
 
Check hardware compatibility 
Before installing or upgrading Windows on your computer, check the hardware in the computer 
to make sure it's compatible with that version of Windows. Microsoft provides a Windows 
Compatible Products List for checking if the hardware in your computer is compatible with the 
chosen version of Windows. 
If one or more pieces of hardware is not compatible with the chosen Windows version, we 
recommend replacing that hardware with compatible hardware or purchasing a new computer. 
Having compatible hardware in your computer helps ensure the Windows install or upgrade 
process is successful. 
 
Genuine Windows CD, DVD, or USB thumb drive 
First, you need a genuine copy of the Microsoft Windows operating 
system installation CD, DVD, or USB thumb drive. A genuine Windows product key is included 
with the installation disc, which is required to activate Windows after installation. If you have 



These notes are edited for Academic Purpose and Private Circulation Only 

Information and Communication Technology 
Ph.D Cell Loknayak Bapuji Aney Mahila Mahavidyalaya, Yavatmal  33 

an OEM (original equipment manufacturer) computer, the Windows product key is often on the 
back or side of the computer. 
If you have an OEM computer (e.g., Acer, Dell, HP, etc.), the computer will not have a genuine 
Windows CD, DVD, or USB thumb drive. Instead, you would reinstall Windows and the 
software using a hidden partition or a set of restore discs. The steps mentioned on this page 
would still work, but you'd need a copy of Windows. You can borrow a friend's Windows disc, 
as long as it's the same version of Windows that came with the computer and have a product key. 
 
Note 
With early versions of Windows, you cannot download a copy of Windows to install on a 
computer. You must purchase a physical copy of Windows. If you are installing Windows 10, 
you can download the Windows 10 Media Creation Tool to create a bootable disc or USB thumb 
drive. For Windows 11, you can download the Windows 11 Installation Assistant. 
 
Warning 
Microsoft has Windows 10 and 11 available for download only from their website. Any other 
site that claims to have copies of other versions of Windows should not be trusted. These copies 
of Windows are pirated software and could contain anything, including spyware or malware. 
 
Installing or upgrading Windows 
To start the Windows install or upgrade process, you need to configure your computer to boot 
from a CD or DVD before booting to the hard drive. Changing the boot process forces the 
computer to look for the Windows installation disc before booting from the hard drive. 

1. Open the CMOS setup. 
 How to enter and exit the BIOS or CMOS setup. 
2. Change the computer's boot order. Set the CD, DVD, or disc drive as the first boot device 

if you are trying to boot from a disc. Or, set the first boot device to your USB drive if 
you're trying to boot from a USB thumb drive. If the drive is not shown, keep the disc is 
inserted and reboot the computer. With the disc in the drive, BIOS should recognize and 
include it in the list. 

3. Save the settings change and exit BIOS. 
Once you have updated the boot order, you can begin the Windows installation process. 

4. Place the Windows disc in the CD/DVD drive or USB thumb drive into the back of the 
computer. 

5. Turn on or restart the computer. As the computer starts up, it should detect the 
installation disc or drive and show a message similar to Press any key to boot from CD. 
Press any key on the keyboard to have the computer boot from the Windows disc or 
drive. 

6. After the Windows install begins, there are several prompts that you need to answer. 
Select either Yes or the appropriate option to install Windows. 

 
Install Note 
Make sure you select the Full Install option and not the Repair or Upgrade option. 
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Upgrade Note 
If you are upgrading to a newer version of Windows, select the Upgrade option instead of 
the Full Install option. 

7. When asked which partition to install Windows onto, select the main partition, usually 
the C: drive or one labeled "Unallocated partition". If upgrading Windows, select the 
existing installation of Windows on the hard drive. 

8. You may be asked if you want to erase all contents on the hard drive, then install 
Windows. We recommend you choose this option, as it also formats the hard drive to 
allow the Windows operating system to be installed. 

 
Tip 
You can use the erase all contents option to uninstall an existing version of Windows on the hard 
drive, then install Windows again. 

9. The computer may need to restart several times during the Windows install process. The 
restarts are normal and if prompted to restart, select the Yes option. 

10. When the install process is nearly complete, the Windows configuration option screens 
are shown. On these screens, you may be asked to select the time zone you live in, your 
preferred language, and the account's name you use to access Windows. Select the 
appropriate options and enter the appropriate information on each configuration screen. 

The Windows install process is completed when the computer prompts you to log in or when it 
loads into Windows. 
Final Windows and computer configuration 
After Windows is installed on the computer, you need to install the drivers and related software 
for the hardware in the computer. You can use the installation discs that came with the hardware 
or download the drivers from the hardware manufacturer's website. 

 How to install and update a computer driver. 
Tip 
If you cannot download drivers because your network card is not working after installing 
Windows, you can download the drivers on another computer. Then, copy them to a USB thumb 
drive, and move them over to your computer. 
 
 
 
Basic Operations in Windows,  
Important Windows Operations 
To use Windows efficiently, you must master a few simple operations, such as pointing and 
clicking, dragging and dropping, and right-clicking. You perform all these operations with your 
mouse. 
Pointing and Clicking 
The most common mouse operation is pointing and clicking. Simply move your computer’s 
mouse or touchpad so that the cursor is pointing to the object you want to select, and then click 
the left mouse button once. Pointing and clicking is an effective way to select menu items, 
directories, and files. 
Double-Clicking 
To launch a program or open a file folder, single-clicking isn’t enough. Instead, you need 
to double-click an item to activate an operation. This involves pointing at something onscreen 
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with the cursor and then clicking the left mouse button twice in rapid succession. For example, to 
open program groups or launch individual programs, simply double-click a specific icon. 
Right-Clicking 
Here’s one of the secret keys to efficient Windows operation. When you select an item and then 
click the right mouse button, you’ll often see a pop-up menu. This menu, when available, 
contains commands that directly relate to the selected object. So for example, if you right-click a 
file icon, you’ll see commands related to that file—copy, move, delete, and so forth. 
Right-clicking is also key to Windows 7’s new Jump List feature on the taskbar. Right-click any 
taskbar icon, and you’ll see a Jump List that contains recently opened documents and essential 
application operations. It’s kind of an extension of the traditional right-click pop-up menu and is 
very useful. 
Refer to your individual programs to see whether and how they use the right mouse button. 
Dragging and Dropping 
Dragging is a variation of clicking. To drag an object, point at it with the cursor and then press 
and hold down the left mouse button. Move the mouse without releasing the mouse button and 
drag the object to a new location. When you’re finished moving the object, release the mouse 
button to drop it onto the new location. 
You can use dragging and dropping to move files from one folder to another or to delete files by 
dragging them onto the Recycle Bin icon. 
Hovering 
When you position the cursor over an item without clicking your mouse, you’re hovering over 
that item. Many operations require you to hover your cursor and then perform some other action. 
Moving and Resizing Windows 
Every software program you launch is displayed in a separate onscreen window. When you open 
more than one program, you get more than one window—and your desktop can quickly become 
cluttered. 
 
TIP 
The cursor changes shape—to a double-ended arrow—when it’s positioned over the edge of a 
window. 
There are many ways to deal with desktop clutter. One way is to move a window to a new 
position. You do this by positioning your cursor over a blank area at the top of the window frame 
and then clicking and holding down the left button on your mouse. As long as this button is 
depressed, you can use your mouse to drag the window around the screen. When you release the 
mouse button, the window stays where you put it. 
With Windows 7, you can quickly move a window to the left or right side of the desktop by 
using a new featured dubbed Aero Snap. Just drag the window to the left side of the screen to 
dock it there and resize it to the left half of the desktop; drag the window to the right side of the 
screen to dock it on that side. 
You also can change the size of most windows. You do this by positioning the cursor over the 
edge of the window—any edge. If you position the cursor on either side of the window, you can 
resize the width. If you position the cursor on the top or bottom edge, you can resize the height. 
Finally, if you position the cursor on a corner, you can resize the width and height at the same 
time. 
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After the cursor is positioned over the window’s edge, press and hold down the left mouse 
button; then drag the window border to its new size. Release the mouse button to lock in the 
newly sized window. 
Peeking at the Desktop 
Want to quickly see what’s beneath all the open windows on the desktop? Have a gadget you 
want to look at? 
Then you’ll appreciate Windows 7’s new Aero Peek feature. With Aero Peek you can, well, peek 
at the desktop beneath all that window clutter. 
You activate Aero Peek from the little transparent rectangular button at the far right of the 
Windows taskbar. Hover the cursor over the Aero Peek button and every open window becomes 
transparent, as shown in Figure 3.2. This lets you see everything that’s on the desktop below. 

 
Figure 3.2 Aero Peek in action—a great way to view gadgets, shortcut icons, and your Windows 
desktop wallpaper. 
Maximizing, Minimizing, and Closing Windows 
Another way to manage a window in Windows is to make it display full-screen. You do this by 
maximizing the window. All you have to do is click the Maximize button at the upper-right 
corner of the window, as shown in Figure 3.3. 

 
Figure 3.3 Use the Minimize, Maximize, and Close buttons to manage your desktop windows. 
If the window is already maximized, the Maximize button changes to a Restore Down button. 
When you click the Restore Down button, the window resumes its previous (premaximized) 
dimensions. 
TIP 
 
Aero Snap provides another way to maximize a window. Use your mouse to drag the window to 
the top of the desktop, and it will automatically maximize. 
If you would rather hide the window so that it doesn’t clutter your desktop, click the Minimize 
button. This shoves the window off the desktop, onto the taskbar. The program in the window is 
still running, however—it’s just not on the desktop. To restore a minimized window, all you 
have to do is click the window’s icon on the Windows taskbar (at the bottom of the screen). 
If what you really want to do is close the window (and close any program running within the 
window), just click the window’s Close button. 
CAUTION 
 
If you try to close a window that contains a document you haven’t saved, you’ll be prompted to 
save the changes to the document. Because you probably don’t want to lose any of your work, 
click Yes to save the document and then close the program. 
Scrolling Through a Window 
Many windows contain more information than can be displayed at once. When you have a long 
document or web page, only the first part of the document or page is displayed in the window. 
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To view the rest of the document or page, you have to scroll down through the window, using the 
various parts of the scrollbar (shown in Figure 3.4). 

 
Figure 3.4 Use the scrollbar to scroll through long pages. 
There are several ways to scroll through a window. To scroll up or down a line at a time, click 
the up or down arrow on the window’s scrollbar. To move to a specific place in a long document, 
use your mouse to grab the scroll box (between the up and down arrows) and drag it to a new 
position. You can also click the scrollbar between the scroll box and the end arrow, which scrolls 
you one screen at a time. 
If your mouse has a scroll wheel, you can use it to scroll through a long document. Just roll the 
wheel back or forward to scroll down or up through a window. Likewise, some notebook 
touchpads let you drag your finger up or down to scroll through a window. 
Using Menus 
Many windows in Windows use a set of pull-down menus to store all the commands and 
operations you can perform. The menus are aligned across the top of the window, just below the 
title bar, in what is called a menu bar. 
You open (or pull down) a menu by clicking the menu’s name. The full menu then appears just 
below the menu bar, as shown in Figure 3.5. You activate a command or select a menu item by 
clicking it with your mouse. 

 
Figure 3.5 Navigating Windows’ menu system. 
Some menu items have a little black arrow to the right of the label. This indicates that additional 
choices are available, displayed on a submenu. Click the menu item or the arrow to display the 
submenu. 
TIP 
 
If an item in a menu, toolbar, or dialog box is dimmed (or grayed), that means it isn’t available 
for the current task. 
Other menu items have three little dots (called an ellipsis) to the right of the label. This indicates 
that additional choices are available, displayed in a dialog box. Click the menu item to display 
the dialog box. 
The nice thing is, after you get the hang of this menu thing in one program, the menus should be 
similar in all the other programs you use. For example, most of the Microsoft Office 2007 
programs have an Office button that, when clicked, displays a pull-down menu of common file-
oriented operations; older programs have a File menu that contains similar operations. Although 
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each program has menus and menu items specific to its own needs, these common menus make it 
easy to get up and running when you install new software programs on your system. 
Using Toolbars and Ribbons 
Some Windows programs put the most frequently used operations on one or more toolbars, 
typically located just below the menu bar. (Figure 3.6 shows a typical Windows toolbar.) A 
toolbar looks like a row of buttons, each with a small picture (called an icon) and maybe a bit of 
text. You activate the associated command or operation by clicking the button with your mouse. 

 
Figure 3.6 A typical Windows toolbar. 
TIP 
 
If the toolbar is too long to display fully on your screen, you’ll see a right arrow at the far-right 
side of the toolbar. Click this arrow to display the buttons that aren’t currently visible. 
Other programs substitute a ribbon for the toolbar. For example, most of the Microsoft Office 
2007 programs have a ribbon that contains buttons for the most-used operations. As you can see 
in Figure 3.7, each ribbon has different tabs, each containing a unique collection of buttons. 
Click the tab to see the ribbon buttons for that particular type of operation. 

 
Figure 3.7 A new-style ribbon, with tabs for different types of operations. 
TIP 
 
If you’re not sure which button does what on a toolbar or ribbon, you can hover the cursor over 
the button to display a ToolTip. A ToolTip is a small text box that displays the button’s label or 
other useful information. 
Using Dialog Boxes, Tabs, and Buttons 
When Windows or an application requires a complex set of inputs, you are often presented with 
a dialog box. A dialog box is similar to a form in which you can input various parameters and 
make various choices—and then register those inputs and choices when you click OK. (Figure 
3.8 shows the Save As dialog box, found in most Windows applications.) 

 
Figure 3.8 Use dialog boxes to control various aspects of your Windows applications. 
Windows has several types of dialog boxes, each one customized to the task at hand. However, 
most dialog boxes share a set of common features, which include the following: 

 Buttons—Most buttons either register your inputs or open an auxiliary dialog box. The 
most common buttons are OK (to register your inputs and close the dialog box), Cancel 
(to close the dialog box without registering your inputs), and Apply (to register your 
inputs without closing the dialog box). Click a button once to activate it. 

NOTE 
 
The operations presented in this chapter are described as how they look and act by default in a 
typical Windows 7 installation. If you’re using someone else’s PC, things might not look or act 
exactly like this. It’s normal for two different PCs to look and act a little differently because you 
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can customize so many options for your own personal tastes—as you’ll learn in Chapter 4, 
“Personalizing Windows.” 

 Tabs—These allow a single dialog box to display multiple “pages” of information. Think 
of each tab, arranged across the top of the dialog box, as a “thumbtab” to the individual 
page in the dialog box below it. Click the top of a tab to change to that particular page of 
information. 

 Text boxes—These are empty boxes where you type in a response. Position your cursor 
over the empty input box, click your left mouse button, and begin typing. 

 Lists—These are lists of available choices; lists can either scroll or drop down from what 
looks like an input box. Select an item from the list with your mouse; you can select 
multiple items in some lists by holding down the Ctrl key while clicking with your 
mouse. 

 Check boxes—These are boxes that let you select (or deselect) various standalone 
options. 

 Sliders—These are sliding bars that let you select increments between two extremes, 
similar to a sliding volume control on an audio system. 

 
 
 
Storing and Managing Data,  

 IT storage management, also called data storage management, involves tracking and 
streamlining the central component of big data that collects and retains digital 
information using computers and other devices. Data storage management refers to the 
process of managing data more effectively. It requires a proper understanding of storage 
devices and the availability of various types of data. 

  
Digital information may include protocols, documents, user preferences, address books, and 
more. Common types of data storage are object storage, file storage, software-defined storage, 
and block storage. Each of these storage types is used for different purposes. 

 What are the different data storage types? 
Cloud storage: Cloud storage enables organizations to store data in the cloud, making it more 
easily accessible to authorized users through the internet. Some of the commonly used cloud 
storage includes Google, Microsoft, and more. 
  
Software-defined storage: Software-defined storage is an approach used to manage data 
through abstraction. It works by abstracting data from the physical storage organized for network 
use. It also works well with containers and microservices that include unstructured data. 
  
File storage: File storage is one of the most common data storage approaches used by 
organizations. It stores data in a hierarchical format as a single piece of information. This helps 
users access data using unique identifiers or paths such as names, locations, and URLs. 
  
Block storage: Block storage divides the storage into independent blocks. Each block has its 
own unique identity that ensures data security and provides the freedom to place small pieces of 
information conveniently for faster retrieval. Blocks are comparatively faster and ideal for rich 
media databases. They can also provide users with complete configuration autonomy. 
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Object storage: In object storage, the data or files are broken into pieces of information known 
as objects. Each object is a self-contained repository with a unique identifier. This helps users 
locate and access information even on a distributed system. 

 How does data storage management work? 
Data storage management involves the monitoring of software and hardware assets, such as 
storage arrays, physical servers, and cloud storage services. Data storage management can 
involve resolving performance issues like potential bottlenecks and analyzing real-time storage 
capacity to help improve the end-user experience. With this information, admins can reallocate 
storage resources to fulfill business storage needs. 
  
Data storage management can also include traffic analysis, process automation, memory 
management, network virtualization, replication, and storage provisioning. Using reliable data 
storage management software, organizations can more easily configure and track storage 
and report related storage activities. 

 What are the functions of data storage management? 
Common functionalities of data storage management include: 
  

o Performance and reliability: The objective of data storage management is to 
manage data to have it readily available for business operations. Easy and quick 
access to data increases the performance, efficiency, and productivity of 
employees and improves the end-user experience. To streamline the process, 
teams can use media and automatic tiering to optimize different storage tiers. 

o Security and data protection: While using cloud storage, it’s important to 
understand the importance of data protection. Protect business-critical data using 
data backup solutions, encryption for both in-transit and stored data, multifactor 
authentication to restrict unauthorized access, and more. 

o Control and compliance: Leverage various levels of tiering or automatic tiering 
to store the most valuable data assets. This helps manage and store data and helps 
organizations demonstrate compliance with regulations. 

 How do storage management tools help with data storage? 
Storage management tools can help you more easily allocate resources as needed. The tools can 
also: 
  

o Help you maintain data in a hierarchy, so it’s more easily accessible for teams 
o Give administrators in-depth visibility into application layers to understand 

storage assets and their performance 
o Send alerts to relevant teams to notify them about the exhausted storage to help in 

delivering a seamless end-user experience 
o Provide key metrics and reports to help admins accommodate with data storage as 

needed 
 What is data management software? 

Data management software is designed to help organizations monitor current data storage 
capacity through a centralized dashboard, so you can more easily optimize data storage policies, 
manage the health of the storage environment, and address key aspects of the data management 
process. 
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Additionally, data monitoring tools can provide crucial insights into the health of storage 
devices, capacity risk, and hotspot detection to ensure the right measures are taken. 
 
 
 
 

Windows User Accounts, The System Settings. Adjusting the Computers Settings. 
 
  
These accounts can be customized and separated from one another, creating unique personal 
environments on one computer. 
  
Whether you’re planning to share a device with friends or family, or simply want to create more 
than one account for yourself, follow our guide. 
  
Manage User Accounts in Windows 10 
  
In summary, to manage a user account in Windows 10, do the following: 
  

1. In the Settings window, click Accounts, and then click Family & other users. 
2. Click the account you want to modify, to display your options. Then click 

Change account type. Click to view a larger image. Any account can be an 
Administrator account. 

3. In the Account type list, click Administrator. Then click OK. 
  
Let's discuss these in detail  
  
It’s important to note that there are two types of user accounts: administrator and standard user. 
Each computer needs at least one administrator account in order to install new applications, 
apply updates, and manage system settings. 
  
In this guide, we’ll show you how to change your account to an administrator if needed. 
  
In Windows 10 terminology, a local user refers to an account created without a Microsoft 
account. This means that you won’t be able to use the same account on a different device and 
lose some cloud functionality. However, you can still customize and manage your account on 
your computer locally.  
  
How to manger user accounts in Windows 10. 
  
How to create a new local user in Windows 10 
  
Creating a new user account is easy using Windows 10’s Settings application. You may also 
create a Microsoft account to be able to transfer accounts and files between computers. 
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1. Click on the Start menu in your taskbar. This icon has the Windows 10 logo on it. If 
you’re not familiar with the Windows 10 interface, we recommend reading the Get 
Started with Windows 10 article on our website. 

2. Select the Settings icon, indicated by a gear. Alternatively, you can use 
the Windows + I keyboard shortcut to reach this application quicker. 

 
3. Click on the Accounts tile. 

 
4. Switch to the Family & other users category using the panel on the left side of the 

screen. You should see a list of all the current users on your computer. 
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5. Click on the Add someone else to the PC button. 

 
6. To add a new local user, select the I don't have this person's sign-in 

information option. 
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7. Click on the Add a user without a Microsoft account option. 

 
8. Enter the desired username. If needed, you can also include a password and a password 

hint. This will give extra privacy to the user of the account. In the future, you’re always 
able to change all of this information. 

 
9. Click Next to finalize the new account. 

  
How to customize a local user on Windows 10 
  
Each user account on your computer can change username, picture, and password at any time. 
The guide below will show you how to customize your local user on a Windows 10 device. 
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1. Click on the Start menu in your taskbar. 

 
2. You’ll see your current user picture on the left side of the panel. Click on it and 

select Change account settings from the context menu. 

 
3. Here, you can modify your profile picture or take a new one using your camera, and 

manage your local account. 
4. If you have a Microsoft account connected, click on the Manage my Microsoft 

account link to be able to modify settings such as password and security. 
  
You can always come back to this menu and make changes whenever needed. 
  
How to make a local user an administrator in Windows 10 
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When you create a new account on Windows 10, it’ll automatically be assigned as a standard 
account without administrative permissions. This means that most accounts on a device won’t be 
able to install new applications and change system settings without reaching out to an 
administrator. 
  
If you want to change an existing account into an administrator account with full access, follow 
the guide below. 
  

1. Click on the Start menu in your taskbar. 
2. Select the Settings icon, indicated by a gear. Alternatively, you can use 

the Windows + I keyboard shortcut to reach this application quicker. 

 
3. Click on the Accounts tile. 
4. Switch to the Family & other users category using the panel on the left side of the 

screen. You should see a list of all the current users on your computer. 
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5. Select the account you want to modify by clicking on it once. Click on the now 
visible Change account type button. 

 
6. Click on the drop-down menu and switch from Standard User to Administrator. 

 
7. Click the OK button. The account now has full access and administrative permissions on 

your device. 
  
How to remove a local user in Windows 10 
  
If an account is no longer needed, you can easily remove it using the guide below. Make sure 
that you save all files stored on the account before permanently deleting it from the device, as 
this action is not reversible. 
  
When you’re ready to remove a local user, follow this guide. 
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1. Click on the Start menu in your taskbar. 

 
2. Select the Settings icon, indicated by a gear. Alternatively, you can use 

the Windows + I keyboard shortcut to reach this application quicker. 
3. Click on the Accounts tile. 
4. Switch to the Family & other users category using the panel on the left side of the 

screen. You should see a list of all the current users on your computer. 
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5. Select the account you want to delete by clicking on it once. Click on the now 
visible Remove button. 

 
6. Make sure to read the warning before clicking the Delete account and data button. 

Wait for Windows 10 to process your request and remove the local user. 
  
Final thoughts 
  
We hope that this guide was able to show you everything you need to know about managing user 
accounts in Windows 10. If you ever need further assistance, our customer service is happy to 
guide you through any issues you might have. 
  
Do you want to learn more about the Windows 10 operating system? We recommend proceeding 
with our Set Up Security in Windows 10 article or backtrack to our main Windows 10 tutorials 
page to find your next lesson.  
  
If you’re looking for more guides or want to read more tech-related articles, consider subscribing 
to our newsletter. We regularly publish tutorials, news articles, and guides to help you. 
 
 
 

Introduction to MS Office. Word Processing with MS-Word : basic 
operations- Editing, Proofing, and Formatting text, paragraphs and pages, Printing the 

documents. Working with tables, images. Mail merge. Working with Charts, Equations, 
Symbols. 

 
MS Office helps simplify basic office tasks and improve work productivity. Each application is 
designed to address specific tasks, such as word processing, data management, making 
presentations and organizing emails. 
Microsoft has developed multiple versions of Office that can be supported by different operating 
systems, including Windows, Linux, and macOS.Microsoft Office is also offered in 35 different 
languages. 
Microsoft Office Common Applications 
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The most common Office applications are Word, Excel, PowerPoint, and Outlook. Other apps 
include Publisher, Access and OneNote. 
Here’s a brief explanation of each of the different apps and what you can use them for: 

 Microsoft Word: is a word processor that lets users make and edit text documents, such 
as reports, letters, and résumés and run spell-checks on writing 

 Microsoft Excel: is an electronic spreadsheet program that helps you store, organize and 
manipulate data by creating simple to complex spreadsheets 

 Microsoft PowerPoint: allows you to visually display information, using anything from 
basic slideshows to professional multimedia presentations 

 Microsoft Outlook: is a personal information manager mainly used for emails, but that 
can also be used to store calendars and contact information, manage tasks as well as 
organize meetings 

 Microsoft Publisher: is a graphic design app that gives users creating material for 
marketing or publications more options in the layout and design of their documents 

 Microsoft Access: is a database management system that allows you to link and use data 
from other sources, manipulate the data you’ve gathered in different ways, as well as 
create simple business applications 

 Microsoft OneNote: is a digital alternative to a paper notebook that allows you to create, 
organize and share your notes easily 

 
Developed by Microsoft, MS Word is amongst the most popular and widely used programs of 
Microsoft Office suite. It is used to make professional-quality write-ups, editing and formatting 
the existing documents, creating graphical documents that comprise images, and more. 
 
Some of the features of MS Word are as follows: 
 
Home: Basic elements that include under this option are font size, font style, font colour, bullets, 
line spacing, alignment, etc. 
 
Insert: In your MS Word document, you can include graphs, shapes, images, charts, tables, 
footer, page number, header, etc. that are available under Insert option. 
 
Design: Under the Design tab, you get a list of templates or designs in which you want your 
document to be created to improve your document’s appearance. 
 
Page Layout: You get options like columns, lines, margins, orientation, spacing, identification, 
etc. under the Page Layout option. 
 
References: References tab is one of the most useful features that can be used by people who are 
writing books or creating a thesis. Under this option, you get options such as bibliography, table 
of contents, caption, citation, footnote, etc. 
 
Review: Under this tab, options line grammar, Thesaurus, spell check, language, translation, 
word count, comments, etc. are included. 
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1. What is Thesaurus in MS Word? 
The Thesaurus is a software tool used in the MS Word that helps you find synonyms and 
antonyms for the selected word. 
 
 

2. Where is the AutoCorrect option in MS Word? 
In your MS Word doc, go to File > Options > Proofing and click on AutoCorrect 
Options. On the AutoCorrect tab, tick mark the box saying Replace text as you type. 
 
 

3. What is the use of the AutoCorrect feature? 
AutoCorrect feature can be used to correct typos, misspelled words, and sentence casing 
errors. Also, it automatically inserts symbols and other text wherever required. 
 
 

4. What is the difference between MS Word and MS Excel? 
A processing document, MS Word is widely used for writing content, essays, editing and 
formatting write-ups, preparing graphical documents with images, etc. Whereas, MS 
Excel is a spreadsheet software where you can save your in a tabular form in numerical 
and alphabetical values. 
 
 

5. What are 20 MS Word shortcut keys? 
Listed down are a few shortcut keys of MS Word: 

o Ctrl + A: Select all contents of the page 
o Ctrl + B: Bold highlighted selection 
o Ctrl + C: Copy selected text 
o Ctrl + X: Cut selected text 
o Ctrl + N: Open new/blank document 
o Ctrl + P: Open the print window 
o Ctrl + I: Italicise highlighted selection 
o Ctrl + U: Underline highlighted selection 
o Ctrl + V: Paste 
o Ctrl + Y: Redo the last action performed 
o Ctrl + Z: Undo last action 
o Ctrl + G: Find and replace options 
o F1: Open help 
o F7: Spell check selected text and/or document 
o F12: Save as 
o Ctrl + S: Save 
o Ctrl + W: Close document 
o Alt + Shift + D: Insert the current date 
o Alt + Shift + T: Insert the current time 
o Ctrl + Backspace: Delete word to the left of the cursor 
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6. What are 10 features of Microsoft Word? 
o Changing case 
o Create a custom tab 
o Quick parts 
o Add placeholder text 
o Edit wrap points when wrapping text 
o Convert a list to a table 
o Convert a bulleted list to SmartArt 
o Quick selection methods 
o Touch/ mouse mode in Word 2013 
o Remove background on an image 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



These notes are edited for Academic 

Information and Communication Technology
Ph.D Cell Loknayak Bapuji Aney Mahila Mahavidyalaya, Yavatmal 

Unit III : INTRODUCTION TO SPREADSHEET SOFTWARE
(Latest Version of the Spreadsheet Software is Recommended)

 
Introduction to MS Excel and its User Interface. 
Introducing Excel 
What is Excel? 
Microsoft Excel is a desktop spreadsheet application, widely used by individuals and 
corporations to perform tasks ranging from basic calculations to building large, complex 
financial models. 
A standard Excel workbook contains one or more sheets. The most common type of sheet is 
called a worksheet. Each worksheet contains cells that are arranged in a grid system of rows and 
columns. Cells can contain a wide range of information (numbers, text, dates, etc.) that is either 
entered directly into the cell or is calculated based on the form
It is this infrastructure that has resulted in Excel becoming the world's most universal calculation 
and analysis tool. 
Excel Interface 
The Excel interface revolves around the
section of the application window. The ribbon is comprised of tabs, which contain groups of 
controls, and this terminology is used to identify the location of tools. For example, bold font is 
applied to the selected range via the Home tab, Font group, Bold button.
The following image shows the Excel 2016 application window with the Home tab active and an 
open workbook containing one empty worksheet:

 
Excel Interface 

 

File Formats 
Introducing File Formats 
An Excel workbook can be saved in several different 
e.g. .xlsx, .xlsm. 
To save a new workbook into a particular format, or convert an existing workbook into a 
different format, select the File tab in the top left corner and select the desired format from the 
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Unit III : INTRODUCTION TO SPREADSHEET SOFTWARE
(Latest Version of the Spreadsheet Software is Recommended)

Introduction to MS Excel and its User Interface.  

spreadsheet application, widely used by individuals and 
corporations to perform tasks ranging from basic calculations to building large, complex 

A standard Excel workbook contains one or more sheets. The most common type of sheet is 
d a worksheet. Each worksheet contains cells that are arranged in a grid system of rows and 

columns. Cells can contain a wide range of information (numbers, text, dates, etc.) that is either 
entered directly into the cell or is calculated based on the formulas within them. 
It is this infrastructure that has resulted in Excel becoming the world's most universal calculation 

The Excel interface revolves around the ribbon, which is the strip of controls across the top 
of the application window. The ribbon is comprised of tabs, which contain groups of 

controls, and this terminology is used to identify the location of tools. For example, bold font is 
applied to the selected range via the Home tab, Font group, Bold button. 
The following image shows the Excel 2016 application window with the Home tab active and an 
open workbook containing one empty worksheet: 

An Excel workbook can be saved in several different formats, each with a unique file extension, 

To save a new workbook into a particular format, or convert an existing workbook into a 
different format, select the File tab in the top left corner and select the desired format from the 
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A standard Excel workbook contains one or more sheets. The most common type of sheet is 
d a worksheet. Each worksheet contains cells that are arranged in a grid system of rows and 

columns. Cells can contain a wide range of information (numbers, text, dates, etc.) that is either 
 

It is this infrastructure that has resulted in Excel becoming the world's most universal calculation 

, which is the strip of controls across the top 
of the application window. The ribbon is comprised of tabs, which contain groups of 

controls, and this terminology is used to identify the location of tools. For example, bold font is 

The following image shows the Excel 2016 application window with the Home tab active and an 

formats, each with a unique file extension, 

To save a new workbook into a particular format, or convert an existing workbook into a 
different format, select the File tab in the top left corner and select the desired format from the 
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Save As menu. Alternatively, use the keyboard shortcut Alt+F+A to activate the Save As dialog 
box, then choose the desired file format from the Save As Type drop down box. 
Comparing File Formats 
Each Excel file format has different levels of functionality and compatibility with different 
versions of Excel. This should be considered when choosing a file format. 
The following table compares the most commonly used Excel file formats: 
File Format  Extension  Compatibility  Functionality 
Excel Workbook  .xlsx  Excel 2007 +  Standard file format with macros 

disabled. 
Excel Macro-Enabled 
workbook 

 .xlsm  Excel 2007 +  Standard file format with macros enabled. 

Excel Binary 
Workbook 

 .xlsb  Excel 2007 +  Compressed file format with macros 
enabled. 

Excel 97-2003 
Workbook 

 .xls  Excel 97 +  Standard Excel 97 -2003 file format with 
macros enabled. 

CSV (Comma 
delimited) 

 .csv  Excel 97 +  Stores tabular data in plain-text form, 
separated by a comma. 

It is important to note that saving a macro-enabled file (e.g. .xlsm, .xlsb) as a macro-disabled file 
(e.g. .xlsx) will result in all macros being removed from the new file. 
Editing Cell Content 
Each cell in a worksheet may contain a constant or a formula. Constants are sometimes referred 
to as 'hard-codes' or 'inputs', although the correct and least misleading terminology is 'constants'. 
An example of both constant and formula cell content is provided below, with the formula bar 
showing the content of each cell: 
Constant  Formula 

 

 

Cell content can always be entered and edited in the formula bar by typing or editing the content 
and pressing Enter. This is sometimes referred to as 'inputting' data, although the correct and 
least misleading terminology is 'entering' data. 
In the formula example in cell A3 above, the reference to cell A2 can be created by first typing 
'=' and then either typing 'A2' or clicking the mouse on cell A2. 
The right-hand example also shows Formula Edit Mode. Excel enters Formula Edit Mode during 
the data entry process, and assists with the entry of formulas by temporarily overlaying precedent 
ranges with colored boxes (as shown for cell A2 in this instance). To enter Formula Edit Mode, 
select the cell to edit and either start typing or press the F2 key. 
Cut, Copy & Paste 
Content within ranges can be moved and copied using Excel's cut, copy and paste commands. 
Copy & Pasting 
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If a range is copied and pasted to another range, a duplicate of the source range is created within 
the destination range. All references to cells
retained. 
Cut & Pasting 
If a range is cut and pasted to another range, the source range is moved to the destination range 
and the content within the destination range is deleted. All references to cells within 
range will move to their corresponding cells within the destination range, but any prior 
references to cells within the original destination range are invalided. Model users should 
therefore take great care when using the cut and paste command.
The following table provides a list of commonly
shortcuts: 
Keyboard 
Shortcut 

 Command 

Ctrl+C  Copies the selected range/object.
Ctrl+X  Cuts the selected range/object.
Ctrl+V  Pastes any cut or copied content.
Ctrl+Z  Uses the Undo command to reverse the last command.
Ctrl+Y  Repeats the last command or action.
Ctrl+R  Copies the contents of the left

to the right.
Ctrl+D  Copies the contents of the top

below. 
Cut Copy Mode 
When a range is cut or copied the selection will have a flashing border to indicate that the 
selected range has been cut or copied. This state is called 'Cut Copy Mode', and is shown below 
in Excel 2016: 

Cut Copy Mode 

Cut Copy Mode can be cancelled by pressing the Escape key.
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If a range is copied and pasted to another range, a duplicate of the source range is created within 
the destination range. All references to cells within the source and destination ranges are 

If a range is cut and pasted to another range, the source range is moved to the destination range 
and the content within the destination range is deleted. All references to cells within 
range will move to their corresponding cells within the destination range, but any prior 
references to cells within the original destination range are invalided. Model users should 
therefore take great care when using the cut and paste command. 
The following table provides a list of commonly-used cut, copy and paste command keyboard 

 

Copies the selected range/object. 
Cuts the selected range/object. 
Pastes any cut or copied content. 
Uses the Undo command to reverse the last command. 
Repeats the last command or action. 
Copies the contents of the left-most cell of the selected range into the cells 
to the right. 
Copies the contents of the top-most cell of the selected range into the cells 

When a range is cut or copied the selection will have a flashing border to indicate that the 
selected range has been cut or copied. This state is called 'Cut Copy Mode', and is shown below 

Cut Copy Mode can be cancelled by pressing the Escape key. 
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If a range is copied and pasted to another range, a duplicate of the source range is created within 
within the source and destination ranges are 

If a range is cut and pasted to another range, the source range is moved to the destination range 
and the content within the destination range is deleted. All references to cells within the source 
range will move to their corresponding cells within the destination range, but any prior 
references to cells within the original destination range are invalided. Model users should 

used cut, copy and paste command keyboard 

most cell of the selected range into the cells 

of the selected range into the cells 

When a range is cut or copied the selection will have a flashing border to indicate that the 
selected range has been cut or copied. This state is called 'Cut Copy Mode', and is shown below 
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Working with workbooks, work sheets. Data Entry techniques.  Defining data set as a Table. 
Setting, Previewing, and Printing under MS-Excel. Performing Calculations on Data. Working 
with Excel Formulas, Functions and Charts. Sorting/ Filtering data. 
 
 
 One of the major uses of Excel is to create different types of charts for a given data set. Excel provides us 
with a lot of modification options to perform on these charts to make them more insightful. 

In this article, we are going to see the most common “Formatting” performed on charts using a suitable 
example shown below. 

Example: Consider the performance of a batsman in a T20 match. The data set contains the runs scored 
by the batsman in various matches.  

 

Now we will insert a bar chart using the above table. To insert a bar chart : 

Select dataset -> Click on Insert -> Chart Sets Pop Down -> 2-D column 

The key steps to format anything on the chart is : 

 Select the part of the chart which needs to be formatted. 

 Right-click on it and select “Format”. The format window will open. 

1. Formatting the Chart Title : 
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Select the Title -> Right Click on it -> Format Chart Title 

 

In the Format Chart Title window, you can change the Font color, add Borders surrounding the title and 
various other modifications can be done. You can also rename the title by simply selecting and retyping a 
new name. 

 

2. Formatting Axis Titles:  

You can add the axis title by using the “+” button in the top right corner of the chart. 
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Now, rename the X-axis and Y-axis by selecting them. You can edit the appearance of the axis title by 
right-clicking on it and selecting “Format Axis Title”. 

 

3. Formatting Data labels:  
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You can add Data Labels by using the “+” button on the top right corner of the chart. 

 

Now open the Format Data Labels Window and can change the Font color, size, alignment, and many 
other options. 

 

4. Formatting Data Series:  

You can change the color of the bar charts by selecting them and then open the “Format Data 
Series” window. By default, on left-clicking once on any of the bars all the data sets bar will be selected. 
If you want to select only one of these bars, left-click twice on the bar which is to be formatted. 



These notes are edited for Academic Purpose and Private Circulation Only 

Information and Communication Technology 
Ph.D Cell Loknayak Bapuji Aney Mahila Mahavidyalaya, Yavatmal  60 

 

5. Formatting Axis:  

This is the most important formatting mostly used by us to change the scale of the axes according to our 
requirements. 
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Bound is used to provide the minimum value from which axis to chart and also the maxim value of the 
axis. The Major unit is used to provide the intervals in the axis. 

6. Formatting Chart Style: 
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 Excel provides us with dynamic chart styles. Select the “Paint brush icon” in the top right corner of the 
chart and select your desired style. 

 

7. Formatting Chart Type:  

Excel provides us with a lot of different charts along with bar charts. To change the chart type : 

Right Click on the Chart -> Select Change Chart Type 
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Now from the Chart Type window select the desired chart type from the list of options as shown below : 

 

8. Formatting Plot Area:  

You can also add a background color to your chart. Select the “Format Plot Area” after right-clicking. 
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These are some of the most frequent formatting done on Excel charts. Excel provides us with dynamic 
options to format a chart and it can be explored with some self-research easily. 

In Excel, the whole entered data in the sheet uses the same formatting by default which can make the data 
look monotonous, dull, and difficult to read. Excel provides a pool of tools called formatting tools which 
customize the data in such a way that it only affects the appearance of the data and not the content.  

How to apply formatting in Excel? 

Following are the steps to apply the formatting: 

1. Select the range of cells on which formatting needs to be done. 

2. Select the suitable formatting tool from the toolbox(ribbon). 

3. Formatting can be observed on the sheet. 

Formatting tools that work on the text and cell appearance can be found in Home Tab [ Font Group ] in 
the ribbon. 

 

Let’s discuss some formatting tools in this article.  

 Font: It changes the writing style of the data. 
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 Font Size: It changes the size of the data, can make it appear big or short. 
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 Increase/Decrease Font Size: It does the same work as by Font Size i.e adjusts the size of the 
font accordingly. However, it gets handy as in only one click, the size is getting changed. 

 

 Bold and Italic: Bold thickens the letter and makes it appear darker than before while Italic, 
italicize the letters. Both are useful when some data needs to be differentiated from the rest. 
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 Underline: This feature marks a line at the foot of the data. 

 

There is a drop-down button on the right of the underline tool, which has two options: Underline and 
Double Underline. Underline is the same as the Underline tool and Double Underline marks two lines 
below the text selected. 

 

 Top and Double Bottom Border: This feature creates the border as per selection from the drop-
down button around the selected cells. This is majorly used to differentiate some cells from the 
drop-down and create tables in large sheets. 

 

The drop-down in the right of the tool has many options in which we can create the borders around the 
cells. 
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 Fill Colour: As the name suggests, it fills the colour in the cell making it distinct from the rest. 
Excel offers a pool of colours from which the choice can be made. 
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 Font Colour: It changes the colour of the font and makes it appear better. Correct colour choices 
can be made from a plethora of options available. 
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The differences can be observed between using the formatting tools and by default: 
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Cell B4 is formatted. It has a different font style, size, double underline, Bold and Italic font, different 
colours, and a thick box border around it whereas cell B7 has default settings. 

More formatting tools are available in Excel that can be explored. 
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Unit IV : INTRODUCTION TO PRESENTATION SOFTWARE 
(Latest Version of the Presentation Software is Recommended) 

Working with MS PowerPoint. Presentation Basics. Adding more components to the slides, 
Formatting Presentations, backgrounds and layout. Applying Themes. Using Slide Master. 

Working 
with Graphics, Images and Clips. Working with Multimedia. Inserting Sound and Narration. 

Delivering Presentations. Animating Objects. Adding Action effects. Live Presentation. Using 
Custom Shows. Saving/Protecting the Presentation. Printing the slides. 

 
Introduction 
PowerPoint is a presentation program that allows you to create dynamic slide presentations. 
These presentations can include animation, narration, images, videos, and much more. In this 
lesson, you'll learn your way around the PowerPoint environment, including the Ribbon, Quick 
Access Toolbar, and Backstage view. 
Watch the video below to learn more about getting started with PowerPoint. 
Getting to know PowerPoint 
PowerPoint 2016 is similar to PowerPoint 2013 and PowerPoint 2010. If you've previously used 
these versions, PowerPoint 2016 should feel familiar. But if you are new to PowerPoint or have 
more experience with older versions, you should first take some time to become familiar with 
the PowerPoint 2016 interface. 
The PowerPoint interface 
When you open PowerPoint for the first time, the Start Screen will appear. From here, you'll be 
able to create a new presentation, choose a template, and access your recently edited 
presentations. From the Start Screen, locate and select Blank Presentation to access the 
PowerPoint interface. 

 
Click the buttons in the interactive below to become familiar with the PowerPoint interface. 
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Working with the PowerPoint environment 
The Ribbon and Quick Access Toolbar are where you will find the commands to perform 
common tasks in PowerPoint. Backstage view gives you various options for saving, opening a 
file, printing, and sharing your document. 
The Ribbon 
PowerPoint uses a tabbed Ribbon system instead of traditional menus. The 
Ribbon contains multiple tabs, each with several groups of commands. For example, the Font 
group on the Home tab contains commands for formatting text in your document. 

 
Some groups also have a small arrow in the bottom-right corner that you can click for even 
more options. 
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Showing and hiding the Ribbon 
The Ribbon is designed to respond to your current task, but you can choose to minimize it if you 
find that it takes up too much screen space. Click the Ribbon Display Options arrow in the 
upper-right corner of the Ribbon to display the drop-down menu. 

 
 Auto-hide Ribbon: Auto-hide displays your workbook in full-screen mode and 

completely hides the Ribbon. To show the Ribbon, click the Expand Ribbon command 
at the top of screen. 

 Show Tabs: This option hides all command groups when they're not in use, but tabs will 
remain visible. To show the Ribbon, simply click a tab. 

 Show Tabs and Commands: This option maximizes the Ribbon. All of the tabs and 
commands will be visible. This option is selected by default when you open PowerPoint 
for the first time. 

Using the Tell me feature 
If you're having trouble finding command you want, the Tell Me feature can help. It works just 
like a regular search bar: Type what you're looking for, and a list of options will appear. You can 
then use the command directly from the menu without having to find it on the Ribbon. 
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The Quick Access Toolbar 
Located just above the Ribbon, the Quick Access Toolbar lets you access common commands 
no matter which tab is selected. By default, it includes the Save, Undo, Redo, and Start From 
Beginning commands. You can add other commands depending on your preference. 
To add commands to the Quick Access Toolbar: 

1. Click the drop-down arrow to the right of the Quick Access Toolbar. 

 
2. Select the command you want to add from the drop-down menu. To choose from more 

commands, select More Commands. 

 
3. The command will be added to the Quick Access Toolbar. 
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The Ruler, guides, and gridlines 
PowerPoint includes several tools to help organize and arrange content on your slides, including 
the Ruler, guides, and gridlines. These tools make it easier to align objects on your slides. 
Simply click the check boxes in the Show group on the View tab to show and hide these tools. 

 
Zoom and other view options 
PowerPoint has a variety of viewing options that change how your presentation is displayed. You 
can choose to view your presentation in Normal view, Slide Sorter view, Reading view, 
or Slide Show view. You can also zoom in and out to make your presentation easier to read. 
Switching slide views 
Switching between different slide views is easy. Just locate and select the desired slide view 
command in the bottom-right corner of the PowerPoint window. 
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To learn more about slide views, see our Managing Slides lesson. 
Zooming in and out 
To zoom in or out, click and drag the zoom control slider in the bottom-right corner of the 
PowerPoint window. You can also select the + or - commands to zoom in or out by smaller 
increments. The number next to the slider displays the current zoom percentage, also called 
the zoom level. 

 
Backstage view 
Backstage view gives you various options for saving, opening, printing, and sharing your 
presentations. To access Backstage view, click the File tab on the Ribbon. 

 
Click the buttons in the interactive below to learn more about using Backstage view. 

 
You can review our lesson on Understanding OneDrive to learn more about using OneDrive. 
Challenge! 
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1. Open PowerPoint 2016, and create a blank presentation. 
2. Change the Ribbon Display Options to Show Tabs. 
3. Click the drop-down arrow next to the Quick Access Toolbar and add New, Quick 

Print, and Spelling. 
4. In the Tell me bar, type Shape and press Enter. 
5. Choose a shape from the menu, and double-click somewhere on your slide. 
6. Show the Ruler if it is not already visible. 
7. Zoom the presentation to 120%. 
8. When you're finished, your presentation should look something like this: 

 
9. Change the Ribbon Display Options back to Show Tabs and Commands. 
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Unit V : INTRODUCTION TO THE INTERNET 
The Internet: an introduction, Meaning and benefits of the Internet? The history of the 

Internet, Differences between Internet and World Wide Web. Connecting to the Internet. 
Web Browsers. User Interfaces of Web Browsers. Browser Customization. Search 

Engines. E-mail: Basic Concepts and terminologies. Using emails. Security and risk in 
Internet. 

E-commerce. E-learning. E-Government. E-entertainment. Top Ten Future Trends- The 
Internet by 2020. 

Introduction to Internet 

Computers and their structures are tough to approach, and it is made even extra tough while you want to 
recognize phrases associated with the difficulty this is already utilized in regular English, Network, and 
the net will appear to be absolutely wonderful from one some other, however, they may seem like 
identical. 

A network is a group of 1 or extra computer systems (Multiple gadgets, additionally called hosts), which 
are related through a couple of channels for the motive of sending and receiving records or media in a 
shared environment. The community also can consist of serval gadgets/mediums that resource 
communique among or extra machines; those gadgets are called Network devices and consist of routers, 
switches, hubs, and bridges, amongst others. 

Internet is a group of computer systems related from all around the world. The Internet protocol suite is a 
framework defined through the Internet standards. Methods are divided right into a layered set of 
protocols on this architecture. The Internet gives a huge variety of statistics and communique offerings, 
which includes forums, databases, email, and hypertext. It is made of the neighborhood to global 
personal, public networks connected through plenty of digital, wireless, and networking technologies. 

The Internet is a worldwide connectivity of hundreds of thousands of computers of various types that 
belong to multiple networks. 

Working of the internet: The internet is a global computer network that connects various devices and 
sends a lot of information and media. It uses an Internet Protocol (IP) and Transport Control Protocol 
(TCP)-based packet routing network. TCP and IP work together to ensure that data transmission across 
the internet is consistent and dependable, regardless of the device or location. Data is delivered across the 
internet in the form of messages and packets. A message is a piece of data delivered over the internet, but 
before it is sent, it is broken down into smaller pieces known as packets. 

IP is a set of rules that control how data is transmitted from one computer to another via the internet. The 
IP system receives further instructions on how the data should be transferred using a numerical address 
(IP Address). The TCP is used with IP to ensure that data is transferred in a secure and reliable manner. 
This ensures that no packets are lost, that packets are reassembled in the correct order, and that there is no 
delay that degrades data quality. 

 

History of Internet  
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The ARPANET (later renamed the internet) established a successful link between the University of 
California Los Angeles and the Stanford Research Institute on October 29, 1969. Libraries automate and 
network catalogs outside of ARPANET in the late 1960s. 

TCP/IP (Transmission Control Protocol and Internet Protocol) is established in the 1970s, allowing 
internet technology to mature. The development of these protocols aided in the standardization of how 
data was sent and received via the internet. NSFNET, the 56 Kbps backbone of the internet, was financed 
by the National Science Foundation in 1986. Because government monies were being used to administer 
and maintain it, there were commercial restrictions in place at the time. 

In the year 1991, a user-friendly internet interface was developed. Delphi was the first national 
commercial online service to offer internet connectivity in July 1992. Later in May 1995, All restrictions 
on commercial usage of the internet are lifted. As a result, the internet has been able to diversify and grow 
swiftly. Wi-Fi was first introduced in 1997. The year is 1998, and Windows 98 is released. Smartphone 
use is widespread in 2007. The 4G network is launched in 2009. The internet is used by 3 billion people 
nowadays. By 2030, there are expected to be 7.5 billion internet users and 500 billion devices linked to 
the internet. 

Uses of the Internet: 

 E-mail: E-mail is an electronic message sent across a network from one computer user to one or 
more recipients. It refers to the internet services in which messages are sent from and received by 
servers.  

 Web Chat: Web chat is an application that allows you to send and receive messages in real-time 
with others. By using Internet chat software, the user can log on to specific websites and talk with 
a variety of other users online. Chat software is interactive software that allows users to enter 
comments in one window and receive responses from others who are using the same software in 
another window. 

 World Wide Web: The World Wide Web is the Internet’s most popular information exchange 
service. It provides users with access to a large number of documents that are linked together 
using hypertext or hyperlinks. 

 E-commerce: E-commerce refers to electronic business transactions made over the Internet. It 
encompasses a wide range of product and service-related online business activities. 

 Internet telephony: The technique that converts analog speech impulses into digital signals and 
routes them through packet-switched networks of the internet is known as internet telephony. 

 Video conferencing: The term “video conferencing” refers to the use of voice and images to 
communicate amongst users. 

Web Client  

The client (or user) side of the Internet. The Web browser on the user’s computer or mobile device is 
referred to as a Web client. It could also apply to browser extensions and helper software that improve the 
browser’s ability to support specific site services. 
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Web browser 

A web browser is a software program software that searches for, retrieves, and presentations material 
which includes Web pages, photos, videos, and different files. The browser sends a request to the 
Webserver, which then transmits the statistics returned to the browser, which presentations the findings at 
the laptop. Mozilla Firefox, Microsoft Edge, Google Chrome, and others are examples of internet 
browsers. 

Webpage 

An internet web page (additionally called a web page) is a report that may be regarded in an internet 
browser at the World Wide Web. HTML (HyperText Markup Language) and CSS (Cascaded Style Sheet) 
are used to generate the primary shape of an internet web page. An internet web page is generally a 
segment of an internet site that carries statistics in plenty of formats, which includes textual content inside 
the shape of paragraphs, lists, tables, and so on. 

The home web page is the beginning or first web page of an internet site. It gives trendy statistics and 
connections to all the internet pages which are associated. Every internet web page has its personal deal 
with. This may be visible withinside the deal with the bar. As a result, if we need to get admission to a 
selected internet web page, the deal needs to be placed inside the browser’s deal with bar. 

Website 

An internet site, in trendy, is a group of statistics approximately statistics prepared into many internet 
pages. An internet site is probably made for a sure motive, subject matter, or to provide a service. An 
internet site (abbreviated as “website” or “site”) is a group of online pages connected collectively through 
links and saved on an internet server. By clicking on links, a tourist can pass from one web page to the 
next. An internet site’s pages also are connected below one area call and proportion a not unusual place 
subject matter and template. 

Search Engine 

Search engines are websites that search on the internet on behalf of users and show a listing of results. 
More than actually written may be discovered on seek engines. You can be capable of looking for 
different online content material which includes photographs, video content material, books, and news, in 
addition to gadgets and offerings, relying on the seek engine you are the use of. 

To make use of the Internet, you do not always want to recognize the deal with an internet site. It is 
crucial to recognize the way to do a look for statistics. Using a seek engine is one of the only methods to 
seek. A seek engine can help you in finding what you are looking for. You also can appearance up net 
maps and instructions to help you to plot your adventure from one factor to some other. Example: Google, 
Bing, DuckDuckGo, yahoo, etc. 

Differentiation between Network and Internet 

The number one distinction between a network and the internet is that a network is made of computer 
systems that are bodily related and may be used as a personal laptop at the same time as additionally 
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sharing records. The Internet, on the alternative hand, might be an era that connects those small and 
massive networks and creates a brand new in-intensity community. 

Advantages of the Internet: 

 It is the best source of a wide range of information. There is no better place to conduct research 
than the internet. 

 Online gaming, talking, browsing, music, movies, dramas, and TV series are quickly becoming 
the most popular ways to pass the time. 

 Because there are hundreds of thousands of newsgroups and services that keep you updated with 
every tick of the clock, the Internet is a source of the most recent news. 

 Because of virtual shops where you may buy anything you want and need without leaving your 
house, internet shopping is becoming increasingly popular. Recently, virtual shops have been 
making a lot of money. 

Disadvantages of the Internet: 

 Spending too much time on the internet is hazardous for the young generation’s health and leads 
to obesity. 

 Children who use the internet develop an addiction, which is quite dangerous. 

 It is now quite easy to decipher someone’s chat or email messages thanks to the hacking 
community. 

 With the emergence of online businesses, virtual stores, and credit card usage, purchasing goods 
without going to the store has never been easier. 

ntroduction 

The Internet is an increasingly important part of everyday life for people around the world. But if you've 
never used the Internet before, all of this new information might feel a bit confusing at first. 

Throughout this tutorial, we'll try to answer some basic questions you may have about the Internet and 
how it's used. When you're done, you'll have a good understanding of how the Internet works, how 
to connect to the Internet, and how to browse the Web. 

What is the Internet? 

The Internet is a global network of billions of computers and other electronic devices. With the Internet, 
it's possible to access almost any information, communicate with anyone else in the world, and do much 
more. 

You can do all of this by connecting a computer to the Internet, which is also called going online. When 
someone says a computer is online, it's just another way of saying it's connected to the Internet. 
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What is the Web? 

The World Wide Web—usually called the Web for short—is a collection of different websites you can 
access through the Internet. A website is made up of related text, images, and other resources. Websites 
can resemble other forms of media—like newspaper articles or television programs—or they can be 
interactive in a way that's unique to computers. 

The purpose of a website can be almost anything: a news platform, an advertisement, an online library, a 
forum for sharing images, or an educational site like us! 
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Once you are connected to the Internet, you can access and view websites using a type of application 
called a web browser. Just keep in mind that the web browser itself is not the Internet; it only displays 
websites that are stored on the Internet. 

How does the Internet work? 

At this point you may be wondering, how does the Internet work? The exact answer is pretty 
complicated and would take a while to explain. Instead, let's look at some of the most important things 
you should know. 

It's important to realize that the Internet is a global network of physical cables, which can include copper 
telephone wires, TV cables, and fiber optic cables. Even wireless connections like Wi-Fi and 3G/4G rely 
on these physical cables to access the Internet. 

When you visit a website, your computer sends a request over these wires to a server. A server is where 
websites are stored, and it works a lot like your computer's hard drive. Once the request arrives, the server 
retrieves the website and sends the correct data back to your computer. What's amazing is that this all 
happens in just a few seconds! 

Watch the video below from Tata Communications to learn more about how the Internet functions. 

Other things you can do on the Internet 

One of the best features of the Internet is the ability to communicate almost instantly with anyone in the 
world. Email is one of the oldest and most universal ways to communicate and share information on the 
Internet, and billions of people use it. Social media allows people to connect in a variety of ways and 
build communities online. 
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There are many other things you can do on the Internet. There are thousands of ways to keep up with 
news or shop for anything online. You can pay your bills, manage your bank accounts, meet new 
people, watch TV, or learn new skills. You can learn or do almost anything online. 

Lesson 2: What Can You Do Online? 

Introduction 

There's almost no limit to what you can do online. The Internet makes it possible to quickly find 
information, communicate with people around the world, manage your finances, shop from home, listen 
to music, watch videos, and much, much more. Let's take a look at some of the ways the Internet is most 
commonly used today. 

Finding information online 

With billions of websites online today, there is a lot of information on the Internet. Search engines make 
this information easier to find. All you have to do is type one or more keywords, and the search engine 
will look for relevant websites. 

For example, let's say you're looking for a new pair of shoes. You could use a search engine to learn about 
different types of shoes, get directions to a nearby shoe store, or even find out where to buy them online! 

 

There are many different search engines you can use, but some of the most popular 
include Google, Yahoo!, and Bing. 

Email 
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Short for electronic mail, email is a way to send and receive messages across the Internet. Almost 
everyone who uses the Internet has their own email account, usually called an email address. This is 
because you'll need an email address to do just about anything online, from online banking to creating a 
Facebook account. 

 

Social networking 

Social networking websites are another way to connect and share with your family and friends online. 
Rather than sharing with just a few people over email, social networks make it easier 
to connect and share with many people at the same time. Facebook is the world's largest social 
networking site, with more than 1 billion users worldwide. 

 

Chat and instant messaging 

Chat and instant messaging (IM) are short messages sent and read in real time, allowing you to 
converse more quickly and easily than email. These are generally used when both (or all) people are 
online, so your message can be read immediately. By comparison, emails won't be seen until recipients 
check their inboxes. 
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Examples of instant messaging applications include Yahoo Messenger and Google Hangouts. Some 
sites, like Gmail and Facebook, even allow you to chat within your web browser. 

Online media 

There are many sites that allow you to watch videos and listen to music. For example, you can watch 
millions of videos on YouTube or listen to Internet radio on Pandora. Other services, 
like Netflix and Hulu, allow you to watch movies and TV shows. And if have a set-top streaming box, 
you can even watch them directly on your television instead of a computer screen. 

 

Everyday tasks 

You can also use the Internet to complete many everyday tasks and errands. For example, you can 
manage your bank account, pay your bills, and shop for just about anything. The main advantage here 
is convenience. Rather than going from place to place, you can do all of these tasks at home! 
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And a whole lot more! 

Remember, these are just a few of the things you'll be able to 
tutorial to learn more about connecting to the Internet and using the Web!

Lesson 3: Connecting to the Internet

How do I connect to the Internet? 

Once you've set up your computer, you may want to purchase
receive email, browse the Web, stream videos, and more. You may even want to set up a
network, commonly known as Wi-
time. 

Watch the video below to learn about connecting to the Internet.

Looking for the old version of this video? You can still view it

Types of Internet service 

The type of Internet service you choose will la
serve your area, along with the types of service they offer. Here are some common types of Internet 
service. 

 Dial-up: This is generally the slowest type of Internet connection, and you should probably
it unless it is the only service available in your area. Dial
unless you have multiple phone lines you will not be able to use your landline and the Internet at 
the same time. 

 DSL: DSL service uses a broadband co
connects to the Internet via a phone line
unlike dial-up, you'll be able to use the Internet and your phone line at the same time.
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Remember, these are just a few of the things you'll be able to do online. Keep working through this 
tutorial to learn more about connecting to the Internet and using the Web! 

Lesson 3: Connecting to the Internet 

Once you've set up your computer, you may want to purchase home Internet access so you can send and 
receive email, browse the Web, stream videos, and more. You may even want to set up a

-Fi, so you can connect multiple devices to the Internet at the same 

learn about connecting to the Internet. 

Looking for the old version of this video? You can still view it here. 

The type of Internet service you choose will largely depend on which Internet service providers
serve your area, along with the types of service they offer. Here are some common types of Internet 

This is generally the slowest type of Internet connection, and you should probably
it unless it is the only service available in your area. Dial-up Internet uses your phone line
unless you have multiple phone lines you will not be able to use your landline and the Internet at 

broadband connection, which makes it much faster than dial
via a phone line but does not require you to have a landline at home. And 

up, you'll be able to use the Internet and your phone line at the same time.
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do online. Keep working through this 

so you can send and 
receive email, browse the Web, stream videos, and more. You may even want to set up a home wireless 

, so you can connect multiple devices to the Internet at the same 

Internet service providers (ISPs) 
serve your area, along with the types of service they offer. Here are some common types of Internet 

This is generally the slowest type of Internet connection, and you should probably avoid 
phone line, so 

unless you have multiple phone lines you will not be able to use your landline and the Internet at 

, which makes it much faster than dial-up. DSL 
but does not require you to have a landline at home. And 

up, you'll be able to use the Internet and your phone line at the same time. 
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 Cable: Cable service connects to the Internet via cable TV, although you do not necessarily need 
to have cable TV in order to get it. It uses a broadband connection and can be faster than both 
dial-up and DSL service; however, it is only available where cable TV is available. 

 Satellite: A satellite connection uses broadband but does not require cable or phone lines; it 
connects to the Internet through satellites orbiting the Earth. As a result, it can be used almost 
anywhere in the world, but the connection may be affected by weather patterns. Satellite 
connections are also usually slower than DSL or cable. 

 3G and 4G: 3G and 4G service is most commonly used with mobile phones, and it 
connects wirelessly through your ISP's network. However, these types of connections aren't 
always as fast as DSL or cable. They will also limit the amount of data you can use each month, 
which isn't the case with most broadband plans. 

Choosing an Internet service provider 

Now that you know about the different types of Internet service, you can do some research to find out 
what ISPs are available in your area. If you're having trouble getting started, we recommend talking to 
friends, family members, and neighbors about the ISPs they use. This will usually give you a good idea of 
the types of Internet service available in your area. 

Most ISPs offer several tiers of service with different Internet speeds, usually measured in Mbps (short 
for megabits per second). If you mainly want to use the Internet for email and social networking, a 
slower connection (around 2 to 5 Mbps) might be all you need. However, if you want 
to download music or stream videos, you'll want a faster connection (at least 5 Mbps or higher). 

You'll also want to consider the cost of the service, including installation charges and monthly fees. 
Generally speaking, the faster the connection, the more expensive it will be per month. 

Although dial-up has traditionally been the least expensive option, many ISPs have raised dial-up prices 
to be the same as broadband. This is intended to encourage people to switch to broadband. We do not 
recommend dial-up Internet unless it's your only option. 

Hardware needed 

Modem 

 

Once you have your computer, you really don't need much additional hardware to connect to the Internet. 
The primary piece of hardware you need is a modem. 

The type of Internet access you choose will determine the type of modem you need. Dial-up access uses 
a telephone modem, DSL service uses a DSL modem, cable access uses a cable modem, 
and satellite service uses a satellite adapter. Your ISP may give you a modem—often for a fee—when 
you sign a contract, which helps ensure that you have the right type of modem. However, if you would 
prefer to shop for a better or less expensive modem, you can choose to buy one separately. 
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Router 

 

A router is a hardware device that allows you to connect several computers and other devices to a 
single Internet connection, which is known as a home network. Many routers are wireless, which allows 
you to create a home wireless network, commonly known as a Wi-Fi network. 

You don't necessarily need to buy a router to connect to the Internet. It's possible to connect your 
computer directly to your modem using an Ethernet cable. Also, many modems include a built-in router, 
so you have the option of creating a Wi-Fi network without buying extra hardware. 

Setting up your Internet connection 

 

Once you've chosen an ISP, most providers will send a technician to your house to turn on the 
connection. If not, you should be able to use the instructions provided by your ISP—or included with the 
modem—to set up your Internet connection. 

After you have everything set up, you can open your web browser and begin using the Internet. If you 
have any problems with your Internet connection, you can call your ISP's technical support number. 

Home networking 
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If you have multiple computers at home and want to use all of them to access the Internet, you may want 
to create a home network, also known as a Wi-Fi network. In a home network, all of your devices 
connect to your router, which is connected to the modem. This means everyone in your family can use 
the Internet at the same time. 

Your ISP technician may be able to set up a home Wi-Fi network when installing your Internet service. If 
not, you can review our lesson on How to Set Up a Wi-Fi Network to learn more. 

If you want to connect a computer that does not have built-in Wi-Fi connectivity, you can purchase a Wi-
Fi adapter that plugs into your computer's USB port. 

Lesson 4: Understanding the Cloud 

What is the cloud? 

You may have heard people using terms like the cloud, cloud computing, or cloud storage. But what 
exactly is the cloud? 

Simply put, the cloud is the Internet—more specifically, it's all of the things you can access 
remotely over the Internet. When something is in the cloud, it means it's stored 
on Internet servers instead of your computer's hard drive. 

Watch the video below to learn more about the cloud. 

Looking for the old version of this video? You can still view it here. 

Why use the cloud? 

Some of the main reasons to use the cloud are convenience and reliability. For example, if you've ever 
used a web-based email service, such as Gmail or Yahoo! Mail, you've already used the cloud. All of 
the emails in a web-based service are stored on servers rather than on your computer's hard drive. This 
means you can access your email from any computer with an Internet connection. It also means you'll be 
able to recover your emails if something happens to your computer. 
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Let's look at some of the most common reasons to use the cloud. 

 File storage: You can store all types of information in the cloud, including files and email. This 
means you can access these things from any computer or mobile device with an Internet 
connection, not just your home computer. Dropbox and Google Drive are some of the most 
popular cloud-based storage services. 

 

 File sharing: The cloud makes it easy to share files with several people at the same time. For 
example, you could upload several photos to a cloud-based photo service like Flickr or iCloud 
Photos, then quickly share them with friends and family. 
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 Backing up data: You can also use the cloud to protect your files. There are apps such 
as Carbonite that automatically back up your data to the cloud. This way, if your computer 
ever is lost, stolen, or damaged, you'll still be able to recover these files from the cloud. 

 

 

What is a web app? 

Previously, we talked about how desktop applications allow you to perform tasks on your computer. But 
there are also web applications—or web apps—that run in the cloud and do not need to be installed on 
your computer. Many of the most popular sites on the Internet are actually web apps. You may have even 
used a web app without realizing it! Let's take a look at some popular web apps. 

 Facebook: Facebook lets you create an online profile and interact with your friends. Profiles and 
conversations can be updated at any time, so Facebook uses web app technologies to keep the 
information up to date. 
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 Pixlr: Pixlr is an image editing application that runs in your web browser. Much like Adobe 
Photoshop, it includes many advanced features, like color correction and sharpening tools. 

 

 Google Docs: Google Docs is an office suite that runs in your browser. Much like Microsoft 
Office, you can use it to create documents, spreadsheets, presentations, and more. And because 
the files are stored in the cloud, it's easy to share them with others. 

 

Lesson 5: Using a Web Browser 

Using a web browser 

A web browser is a type of software that allows you to find and view websites on the Internet. Even if 
you didn't know it, you're using a web browser right now to read this page! There are many different web 
browsers, but some of the most common ones include Google Chrome, Safari, and Mozilla Firefox. 

No matter which web browser you use, you'll want to learn the basics of browsing the Web. In this lesson, 
we'll talk about navigating to different websites, using tabbed browsing, creating bookmarks, and 
more. 

Watch the video below to learn the basics of using a web browser. 
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We'll be using the Google Chrome web browser throughout this lesson, but you can use any browser 
you want. Keep in mind that your browser may look and act a bit differently, but all web browsers work 
in basically the same way. 

URLs and the address bar 

Each website has a unique address, called a URL (short for Uniform Resource Locator). It's like a street 
address that tells your browser where to go on the Internet. When you type a URL into the 
browser's address bar and press Enter on your keyboard, the browser will load the page associated with 
that URL. 

In the example below, we've typed www.bbc.com/travel into the address bar. 

 

Links 

Whenever you see a word or phrase on a website that's blue or underlined in blue, it's probably 
a hyperlink, or link for short. You might already know how links work, even if you've never thought 
about them much before. For example, try clicking the link below. 

Hey, I'm a link! Click me! 

Links are used to navigate the Web. When you click a link, it will usually take you to a different 
webpage. You may also notice that your cursor changes into a hand icon whenever you hover over a link. 

 

If you see this icon, it means you've found a link. You'll find other types of links this way too. For 
example, many websites actually use images as links, so you can just click the image to navigate to 
another page. 

Review our lesson on Understanding Hyperlinks to learn more. 

Navigation buttons 

The Back and Forward buttons allow you to move through websites you've recently viewed. You can 
also click and hold either button to see your recent history. 

 

The Refresh button will reload the current page. If a website stops working, try using the Refresh button. 
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Tabbed browsing 

Many browsers allow you to open links in a new tab. You can open as many links as you want, and 
they'll stay in the same browser window instead of cluttering your screen with multiple windows. 

To open a link in a new tab, right-click the link and select Open link in new tab (the exact wording may 
vary from browser to browser). 

 

To close a tab, click the X. 

 

To create a new blank tab, click the button to the right of any open tabs. 

 

Bookmarks and history 

If you find a website you want to view later, it can be hard to memorize the exact web 
address. Bookmarks, also known as favorites, are a great way to save and organize specific websites so 
you can revisit them again and again. Simply locate and select the Star icon to bookmark the current 
website. 
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Your browser will also keep a history of every site you visit. This is another good way to find a site you 
visited previously. To view your history, open your browser settings—usually by clicking the icon in the 
upper-right corner—and select History. 

Downloading files 

Links don't always go to another website. In some cases, they point to a file that can be downloaded, or 
saved, to your computer. 

If you click a link to a file, it may download automatically, but sometimes it just opens within your 
browser instead of downloading. To prevent it from opening in the browser, you can right-click the link 
and select Save link as (different browsers may use slightly different wording, like Save target as). 

 

Review our lesson on Downloading and Uploading to learn more. 

Saving images 

Sometimes you may want to save an image from a website to your computer. To do this, right-click the 
image and select Save image as (or Save picture as). 

Plug-ins 

Plug-ins are small applications that allow you to view certain types of content within your web browser. 
For example, Adobe Flash and Microsoft Silverlight are sometimes used to play videos, while Adobe 
Reader is used to view PDF files. 

If you don't have the correct plug-in for a website, your browser will usually provide a link to download 
it. There may also be times when you need to update your plug-ins. Review our lesson on Installing and 
Updating Plug-ins to learn more. 
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